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Introduction 

What is WYNN? 
WYNN (What You Need Now) is a software program for people 
who struggle with reading and writing. The features in WYNN 
allow you to: 

• Scan documents, such as textbook passages, memos, or 
magazine articles, into WYNN and save them 

• Open an existing or newly scanned document and have WYNN 
read it aloud to you 

• Easily change the way the text looks to make it easier to read 

• Use writing tools to make writing assignments easier 

• Use study tools to help you learn  

WYNN uses a series of color-coded toolbars to help you quickly 
access reading and writing assignments. You can do almost 
everything using the buttons on the toolbars that appear across 
the top of the screen. Refer to Getting to Know WYNN for more 
information.  
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WYNN Wizard and WYNN Reader 
Two versions of WYNN software are available: WYNN Wizard and 
WYNN Reader. 

WYNN Wizard is a full-featured application that includes: 

• Optical character recognition (OCR), which allows you to scan 
and read pages, as well as read existing word processing and 
text files  

• Document composition and editing with tools like word 
prediction, spell checking, and homophone recognition 

• The ability to browse the World Wide Web to assist with topic 
research  

• Traditional study aids like highlighting, bookmarking, outlining, 
and dictionary and thesaurus usage 

• Visual and auditory adjustments to make it easier to read and 
comprehend documents  

• Single-user or network licensing available 

WYNN Reader includes the same features and functionality that 
are in WYNN Wizard, except for scanning and OCR capabilities. 
Use WYNN Reader to read electronic documents, create or edit 
documents, and browse the Internet for document research. 

Single-User and Network Versions 

Both WYNN Wizard and WYNN Reader are available as single-
user or network licensed products. The single-user version easily 
installs onto a single PC, while the network version allows as 
many clients as possible, based on the number of licenses 
purchased, to use the software at once over a local area network 
(LAN).    
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What’s in this Box? 
The following items are in your WYNN package. If you discover 
damaged or missing items, please contact your retailer. 

• CD wallet containing one WYNN program CD, several AT&T 
Natural Voices™ CDs, an Authorization CD with Authorization 
number and serial number for the single-user and network 
versions  

• Microphone 

• Datasheet(s) 

• WYNN User’s Guide 

• Authorization number labels (Non-network Multi-user version 
only) 

Online Help 
There are several ways to get help when using WYNN.   

• Help topics  

• Status Bar Help 

• Context-Sensitive Help 

• Readme file 

Help Topics 

To open online help, do one of the following: 

• Click the Help menu, and then click the WYNN Help command. 
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…OR… 

• Press the F1 key. 

The following illustration shows the various components of the 
Help window that appears. 

 

Use the Table of Contents (left window pane), the Index or 
Search tabs, and the topic links (right window pane) to select and 
view an area of interest. When you are done, click the Close 
button –  – on the title bar to close the online Help. 
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Status Bar Help 

When you move the mouse pointer over a menu command, the 
status bar at the bottom of the window displays a short description 
of the command.   

 

Context-Sensitive Help 

WYNN’s context-sensitive help shows information about a specific 
option or button in a dialog box. There are three types of context-
sensitive help: 

• The Question Mark button 

• The F1 key 

• The What’s This? button 

To use context-sensitive help: 

1. Click the Question Mark button –   – in the upper right 
corner of the dialog box, which changes the appearance of 
the mouse pointer.  
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2. Click any option in the dialog box. WYNN displays a context-
sensitive help message for that item.   

 

… OR … 

1. Select an item within a dialog box, and press the F1 key. 
WYNN displays a context-sensitive help message for that 
item.  

… OR … 

1. Use your mouse to right click within the dialog box. The 
pointer becomes a floating What’s This? button. For 
example: 

 

2. Click the button on an item to open the context-sensitive 
help message for that item. 

The Readme File 

WYNN’s Readme file gives you the latest software release 
information. It is available during product installation and, later, in 
the WYNN program group.  
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To open and read the Readme file: 

1. From the Windows Start menu, click All Programs or 
Programs, and then point to the WYNN program folder. 

2. Click the WYNN Readme shortcut to open the Readme file.  

Contacting Freedom Scientific 
Use the following options to contact Freedom Scientific’s support 
staff.  

• World Wide Web site: http://www.FreedomScientific.com/lsg 

• Technical Support e-mail: Support@FreedomScientific.com 

• Technical Support Telephone: (727) 803-8600  

When contacting Freedom Scientific, be prepared to provide the 
following information: 

• Product name, version number, and serial number  
(This information appears in the About dialog box, which is 
available from the Help menu.) 

• Type of computer hardware you are using 

• Version of Windows running on your machine 

• Exact wording of any messages on your screen 

• What you were doing when the problem occurred 

• Steps you have taken to solve the problem 

Technical support is available Monday through Friday from 8:30 
am to 7:00 pm, Eastern Time (ET). 
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WYNN Single-User and Non-Network 
Multi-User Installation 

Important: The procedures in this chapter assume that you can 
access the Internet from your PC for software activation. If 
you do not have Internet access, refer to Activation Options 
for alternate activation procedures.  

This chapter describes how to: 

• Copy your WYNN Authorization number from the Authorization 
CD to your PC. 

Note: The single-user version uses the Authorization CD, while 
the Non-Network Multi-User (NNMU) version uses 
Authorization numbers printed on supplied labels. 

• Install the WYNN Wizard or WYNN Reader application software 
onto your PC 

• Install AT&T Natural Voices™ speech software onto your PC 

• Activate your WYNN software 

Note: If you are installing the network version of WYNN, refer to 
Network WYNN Installation.  

Before You Begin 
• Verify the minimum system requirements 

• Verify that you have an Internet connection (required to activate 
your software quickly using the Internet) 

• Determine if you are installing the non-network multi-user or 
single-user WYNN version versus the WYNN network version.  

• Uninstall any previous version of WYNN (see Uninstalling 
Previous WYNN Software) 
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WYNN Installation Process 
WYNN installation is a four-step process. 

• First, you must insert the WYNN Authorization CD and copy the 
Authorization number to your PC (single-user program only).  

• The next step is to install the WYNN application using the 
WYNN program CD.  

• Once the application is installed, remove the WYNN program 
CD, and insert an AT&T Natural Voices CD. Install as many of 
the AT&T Natural Voices as you like.  

• Finally, open the WYNN application and activate the program. 
Activation is a one-time task that enables and registers your 
single-user or NNMU software with Freedom Scientific. You 
must activate the application before you can use WYNN. 

Copying the WYNN Authorization Number 

The Authorization CD contains a 20-digit alphanumeric number 
that you must transfer to your PC. The Authorization number is 
part of the Internet License Manager (ILM) activation process. You 
must activate your WYNN application before it can be used.  

Important: The WYNN NNMU program does not use an 
Authorization CD. Instead, its Authorization numbers are 
printed on a label sheet. Assign one label to each PC that 
will use the WYNN program, and enter that number into the 
Authorization number field when prompted. Refer to 
Activating WYNN for more information.  

To copy the Authorization number for the WYNN single-user 
program: 

1. Close all applications and insert the WYNN Authorization CD 
into your CD-ROM drive. 
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The Authorization Number dialog appears and shows your 
Authorization number.  

 

2. Click OK.  

3. Remove the Authorization CD and insert the WYNN 
application CD. 

Installing WYNN Wizard or WYNN Reader  

The following describes how to install the single-user and non-
network multi-user versions of WYNN Wizard and WYNN Reader.  

Note: Always install the WYNN application before installing the 
AT&T Natural Voices™ speech software, which is provided 
on separate installation CDs.  

To install the WYNN Wizard or WYNN Reader application: 

1. After inserting the WYNN application CD, the WYNN 
InstallShield wizard window appears.  

Click Next and follow the on-screen instructions.  

2. When installation is complete, the InstallShield Wizard 
Complete window appears.  
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Note: When performing an upgrade, it may be necessary to reboot 
your PC. Click Yes when prompted if this is the case.  

Click Finish.  

The WYNN application is installed, and the WYNN 
application and WYNN Documents folder icons appear on 
your desktop. 

 or       

and   

3. Remove the WYNN application CD, and insert an AT&T 
Natural Voices CD.  

Installing AT&T Natural Voices 

Install the AT&T Natural Voices speech software after you finish 
installing the WYNN application. To install AT&T Natural Voices, 
do the following. 

1. After inserting an AT&T Natural Voices CD into your 
computer’s CD-ROM drive, let the auto-run feature start the 
installation.  

2. Follow the on-screen instructions.  

3. Repeat these steps to install additional voices. Remove the 
AT&T Natural Voices CD from your PC when complete.  

Note: To select an AT&T Natural Voices speech engine, refer to 
Changing WYNN’s Voice or Language Settings. 
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Note: You must activate the WYNN application before you can 
use it. Refer to the next section for WYNN activation 
procedures. 

Activating WYNN  

Note: The following procedure assumes that your PC has Internet 
access. If you cannot connect to the Internet, refer to the 
Activation Options section for more information.  

1. Open WYNN by clicking the WYNN desktop icon or selecting 
the WYNN program from the Start button.  

2. The WYNN Activation dialog box appears the first time you 
open WYNN. Click Activate. 
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3. The WYNN activation options appear. Choose Now, using 
the Internet (Recommended), and click Next.  

 



WYNN Single-User and Non-Network Multi-User Installation 

 

  15  

4. The Authorization Number edit box appears and contains 
your Authorization number. Click Next.  

Important:  
For NNMU installation, the Authorization Number edit box 
is blank. Enter the Authorization number that appears on 
the Authorization number label sheet into the edit box, and 
then click Next.  
 
For the single-user version, the Authorization number also 
appears on your WYNN product packaging. Type the 
number into the edit box if it does not automatically appear 
in the Authorization Number edit box.   

 

This process may take several minutes to complete. During 
this time, the Processing Request dialog appears. 
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You may be prompted to register your software. If you have 
not registered your software, you are asked to do so now. 
Registering lets you receive technical support. Choose 
Register Now and complete the online registration form by 
following the instructions provided.  

5. If the activation is successful, a confirmation message 
appears. Click Finished, which completes the activation.  

If the activation fails, a detailed error message appears that 
recommends you verify or reenter your authorization code, 
or that you contact Freedom Scientific for assistance. 
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Microphone Installation 
To install the microphone: 

1. Assemble the microphone and microphone stand. 

2. From the rear of the computer, locate the MIC jack on the 
sound card, and plug the microphone into the MIC jack. 

3. If your microphone has an on/off switch, use it to turn the 
microphone on or off.  

Uninstalling Previous WYNN Software 
To uninstall the WYNN application: 

1. Make sure that your existing version of WYNN is not 
running.  

2. Do one of the following depending on your version of 
Windows: 

• From your desktop, click the Start button, click 
Control Panel, and double-click Add or Remove 
Programs. 

…OR… 

• From your desktop, click the Start button, point to 
Settings, click Control Panel, and double-click Add 
or Remove Programs.  

3. Select WYNN Wizard X or WYNN Reader X (where X is the 
software version number) in the list of programs and click 
the Change/Remove button.  
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The WYNN InstallShield Wizard appears. Follow the on-
screen instructions to uninstall your WYNN software. You 
may also be required to reboot your PC during the uninstall. 
If this is necessary, a message appears stating that you 
must reboot.  

Note: During this procedure, a message appears stating that the 
Freedom Import Printer cannot be removed. This is normal.  

 

Click OK to continue. 
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Network WYNN Installation 
Note: This chapter is intended for network administrators. It 

assumes that you are familiar with PC networks, user 
groups, user accounts, and user permissions. You must 
have Administration or Power User access on all machines 
where the server, license server, and client components 
are installed.  

Note: If you are installing the single-user or NNMU version of 
WYNN, refer to WYNN Single-User and Non-Network 
Multi-User Installation.  

Network WYNN Installation consists of four major parts.  

Part 1 is the installation of WYNN components onto the network 
server. This consists of installing software from the Network 
WYNN CD to the WYNN Wizard or WYNN Reader directory on the 
server. 

Part 2 is the installation and activation of the Internet License 
Manager (ILM) software. This allows you to designate a server, 
client PC, or another PC on the network as the ILM license server. 
This PC issues tokens to the WYNN clients. The number of 
license seats purchased, determines the number of tokens 
available to client PCs on the network.  

Part 3, which occurs on the network server, is the creation of a 
WYNN user group and the establishment of user permissions to 
specific WYNN folders. These folders appear during WYNN server 
component installation. 

Part 4 is the installation of the WYNN application and AT&T 
Natural Voices from the server to the client PCs.  
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Network WYNN Server Requirements 
• One of the following server operating systems: Windows 2000 

Server/Advanced Server; Windows 2003; Novell Netware 3.1 or 
higher; Linux server (contact Freedom Scientific if you have a 
question about another operating system)  

• At least 300 MB of disk space on the server  

• A Pentium processor  

• At least 64MB RAM on the server  

• CD-ROM drive  

• Minimum desktop area of 800x600 pixels  

• A display resolution of at least 16-bit high color  

Client Requirements 

The client PC requirements are outlined in the System 
Requirements section of this document. However, note that the 
client PCs have the additional requirement that each workstation 
must be connected via a Local Area Network (LAN) or Wide Area 
Network (WAN) to a file server running one of the following: 

• Novell NetWare  

• Windows NT 4.0 Server  

• Windows 2000 Server  
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Installing the Network WYNN Server 
Components 

Network installation requires that you install all server components 
from the Network WYNN CD to the server. During this process, all 
client installation files are copied to the server, and several WYNN 
folders are created.  

1. Insert the Network WYNN CD into the server’s CD-ROM 
drive.  

Important: The installation program for WYNN’s server 
components is located in the CD’s root folder. Installation 
must run from this location. Do not copy and run the 
installation components from a different medium.  

The Auto-Run feature starts and the WYNN installation 
wizard screen appears. Click the Next button. 
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Note: If the CD does not automatically launch, perform the 
following:  
 
Open Windows Explorer, choose the CD-ROM drive, and 
select Setup.exe.  
 
The Network WYNN installation wizard appears.  

2. Read the License Agreement. If you accept the terms, 
choose Yes.  

3. Next, enter a user name and company name, and then 
select Next.  
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4. By default, Network WYNN installs in C:\WYNN4nw. If you 
want to install it in a different folder, choose Browse and 
select a new folder. Choose Next to continue with the 
installation.  
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5. By default, the document storage location is 
C:\WYNN4nw\Users. This location must be shared so that all 
users can access it, and eventually create their own log-in 
folder. Make sure the storage location is shared and then 
select Next to continue.  

 

 

Note: After selecting Next, if the target directory has not yet been 
shared, a Yes/No prompt appears stating that the selected 
location must be shared. Do one of the following: 
 
Select Yes to automatically share the target directory.  
   
Select No to manually share the target directory.   

           When installation is complete, properly adjust the 
permissions for the shared directory. Refer to the Sharing a 
Folder section for sharing and permission procedures.  
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6. Click the Finish button when installation is complete.  

 

If the correct user permissions are in place, you can run the 
WYNN Wizard or WYNN Reader installation from the client 
by connecting to the server and running the setup.exe file.  

7. Refer to Installing WYNN Wizard or WYNN Reader Software 
for client installation procedures.  

Sharing a Folder 

To share a folder during installation: 

• Use Windows Explorer to locate the folder. Next, right-
click on the folder and select Properties. The User 
Properties dialog box appears.  
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• Select the Share this folder option.  

• Select the Permissions button and allow Full Control, 
Change, and Read permissions to all users. 

• Select the OK button twice to close the Permissions 
and User Properties dialog boxes, and continue with 
the Network WYNN installation.  
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During installation, several new folders and subfolders are 
created and appear on the server. For a brief description of 
these folders, refer to the WYNN Folders and Subfolders 
section.  
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WYNN Folders and Subfolders 

The following image and table show Network WYNN’s default 
folder structure.  

 

Folder Description 

WYNN4nw Default Network WYNN folder. 

WYNN Wizard 
ENG 

Default WYNN Wizard folder. In this 
example, ENG indicates English. The 
client setup is launched from this folder. 

WYNN Reader 
ENG 

Default WYNN Reader folder, in this 
example ENG indicates English. The 
client setup is launched from this folder. 
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Folder Description 

LICENSE Contains the INI file that stores the 
location of all user default folders. This 
folder is required to run a WYNN client 
installation. 

USERS Contains all user folders that are 
created when a user initially logs on to 
WYNN. During installation, this folder 
can be renamed and saved to a new 
location on the server instead of 
WYNN4nw, the default Network folder. 

SHARED This folder is shared among users on 
the network. It contains the subfolders 
Docs, Settings, and Audio. Files that 
are used for broadcasting are placed in 
these folders. 

USER An individual user’s folder that has the 
same label as the user’s log in ID. 

DOCS For the Shared folder, it contains all 
sample WYNN files. For the User folder, 
it contains the user’s saved files. 

SETTINGS For the Shared folder, it contains default 
and broadcast system settings. For the 
User folder, it contains new system 
settings created and saved by the user. 

AUDIO For the Shared folder, it contains MP3 
and WAV files for broadcasting. For the 
User folder, it contains MP3 and WAV 
files saved by the user.  
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License Server Installation and Configuration 
Overview 

A Network WYNN Authorization CD is supplied with the Network 
WYNN version. The following overview describes the three 
primary steps to installing and configuring a license server PC.  

• Select a license server PC 

After installing the WYNN server components, you 
must designate one Microsoft Windows-based PC in 
the network to be the license server. Install the license 
server on the network server or a network PC that is 
not running the WYNN client. Make sure that this PC is 
always accessible.  

The license server issues tokens to WYNN client PCs 
on the network. The token lets a client PC use the 
WYNN application. The number of client PCs that can 
run the WYNN application simultaneously is based on 
the number of license seats purchased. For example, if 
10 seats are purchased, only 10 simultaneous WYNN 
sessions are available. If an eleventh PC tries to use 
the WYNN application, it is denied access to the 
application until a license seat becomes available.   

• Install the license server software 

The WYNN Network Authorization CD contains the 
network authorization utilities, documentation, and 
tools. Insert the CD into the PC’s CD-ROM drive, and 
follow the on-screen instructions to install the software.  
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• Activate the license server PC 

This is the only PC that requires software activation. 
The other WYNN client PCs do not require 
authorization or activation since they obtain tokens 
from the license server. This allows the client PCs to 
use the WYNN application.  

For activation procedures, refer to the Activating the 
License Server section.  

Installing the License Server Software and 
Network Authorization Tools 

The following process describes how you install the license server, 
which authorizes client systems to use your Freedom Scientific 
product. This installation also creates a program folder in your 
Start menu that provides access to Network Authorization 
documentation and tools.  
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1. To begin the installation, insert the WYNN Network 
Authorization CD into your computer’s CD-ROM drive. The 
Network Authorization Utilities dialog box appears. Choose 
Install to continue.  

 

Note: If the installation does not begin automatically, select the 
Start button, choose Run, type “D:\Setup.exe” and press 
ENTER. If your CD-ROM drive is not D, then substitute the 
correct letter.  

The Network Authorization Utilities installation status 
appears. The installation briefly pauses, and then launches 
the InstallShield Wizard for the SentinelLM Server.  
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2. The InstallShield Wizard for SentinelLM Server starts. 
Choose Next to begin the license server installation. 

 

Note: You can only install the license server on a computer that 
runs Windows 95 or later. The license server does not 
support other operating systems such as Novell, UNIX, 
Linux, and so on.  

3. Read the license agreement. If you accept the terms and 
conditions in the agreement, choose Yes. 
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4. By default, the license server installs in C:\Program 
Files\Rainbow Technologies\SentinelLM 7.2.0.6 Server. If 
you want to install the license server in a different folder, 
choose Browse and select a new folder. Choose Next to 
continue with the installation. 

 

When the license server installation is complete, the Finish 
dialog box appears.  
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5. Choose Finish when installation of the SentinelLM Server is 
complete. 

 

The Network Authorization installation status menu appears 
again. The Finish dialog appears when installation is 
complete.  
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6. Choose Finish when this installation of the Network 
Authorization Utilities is complete.   

 

The Network Authorization tools and license server are now 
installed. If you are using Windows XP, NT, or 2000, the 
“SentinelLM” service is automatically added to your Windows 
Services.  

The installation creates a new folder in your Start menu 
called Freedom Scientific. The following is a brief 
description of each  Network Authorization tool shortcut that 
appears in this folder. 
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Network 
Authorization 
Tool 

Description 

Quick Start 
Guide  

The quick start guide for Freedom 
Scientific Network Authorization. 

Server 
Administration  

Launches the WLMAdmin utility that 
allows you to monitor the license server 
and perform some administrative 
actions. For more information, refer to 
the System Administrator’s Guide. 

Service Loader  Adds or removes the license server as 
a service called “SentinelLM” in your 
Windows NT System Service registry. 
On Windows NT systems, the license 
server must be running as a service in 
order to authorize client systems. 

System 
Administrator’s 
Guide 

Contains additional information on 
license management, installation, 
optional features, administrator 
commands, user options, and 
environment variables. 

Uninstall 
Network Setup  

Uninstalls Network Authorization 
documentation and tools and 
(optionally) the license server.  

Update WYNN 
Authorization  

Begins the activation process for your 
Freedom Scientific product.  
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Activating the License Server 

After installing the license server and Network Authorization tools, 
you must then activate your Freedom Scientific product license. To 
do this, you must request an Activation License code from 
Freedom Scientific. You can use the Internet to receive your 
Activation License code quickly and easily.  

Perform the following to activate your Freedom Scientific product:  

1. From the Start menu, choose Programs or All Programs, 
Freedom Scientific, Network, and Update WYNN Wizard 
Authorization or WYNN Reader Authorization. 

2. Choose the Activate button to begin the activation.  
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3. Select the Now, using the Internet (RECOMMENDED) 
option to specify that you want to use the Internet to acquire 
your Activation License code. Choose Next to continue.  
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4. Your 20-character Authorization number is automatically 
inserted into the Authorization Number edit box. If your 
Authorization number is not shown, type it into the edit box. 
(Your 20-character Authorization number appears on your 
WYNN CD package.) Choose Next to continue.  

 

5. You may be prompted to register your software. If you have 
not registered your software, you are asked to do so now. 
Registering lets you receive technical support. Choose 
Register Now and complete the online registration form by 
following the instructions provided. You can choose to 
register later, but you must register the next time you 
activate the software on any computer. 

6. After you submit your registration, Internet License Manager 
(ILM) attempts to activate the software. This process may 
take several minutes. When the activation is successful, 
choose Finish.  
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Note: If Internet License Manager cannot activate the software, 
you may need to reconfigure your firewall. For more 
information, see Activating through a Firewall.  

7. If the WLMAdmin utility is running, quit the program; restart 
the utility by opening the Start menu and choosing 
Programs or All Programs, Freedom Scientific, Network, 
and Server Administration. You can use this utility to 
monitor where the license(s) reside and which users are 
using tokens. 

You can now install the Freedom Scientific product on the client 
systems. Refer to Installing WYNN from a Client PC for more 
information.  

Creating a User Group and Configuring 
Permissions 

As a network administrator, create a WYNN user group so that 
you can easily add students who will use the WYNN application. 
After creating the user group, you can then grant permissions to 
several WYNN folders that students must access.  

The following is an overview of user group and WYNN folder 
permission settings.  
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• Create a user group titled WYNN Users in which you 
add users so that they receive the proper server 
permissions. 

For example: 
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• For the WYNN4nw installation folder on the server, 
give the WYNN user group the shared permissions 
Change and Read.  

For example:  
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• For the WYNN4nw installation folder on the server, 
give the WYNN user group the permissions Read & 
Execute, List Folder Contents, and Read.   

For example: 
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• For the License folder on the server, give the WYNN 
user group the permissions Read & Execute, List 
Folder Contents, and Read.  

For example: 
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• For the Users folder on the server, give the WYNN 
user group the permissions Full Control.  

For example: 
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• For the WYNN Wizard Eng or WYNN Reader Eng 
folders on the server, give the WYNN user group the 
permissions Read & Execute, List Folder Contents, 
and Read permissions.  

For example: 
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Installing WYNN from a Client PC 
The final part of network installation requires that you install the 
WYNN application onto the client PCs by running the appropriate 
Setup.exe file that resides on the server.  

Important: Do not run the client setup from the CD.  

You do not need to perform additional authorization procedures for 
these computers. Each time the software is started on the client, it 
automatically searches for the license server and obtains an 
authorization token.  

The number of tokens available depends on the number of users 
permitted by your license. For example, if you purchase a license 
for five users, your license server has five tokens available. Each 
time a user starts the software, the license server assigns the 
client computer a token. Once all tokens are assigned, no 
additional clients can receive authorization.  

If you need your license to support additional users, contact your 
local distributor or Freedom Scientific to purchase additional seats.  

To run the Setup.exe file from the server, follow the procedures 
described in the Installing WYNN Wizard or WYNN Reader 
section of the WYNN installation chapter. 
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Adding the Environment Variable 
LSFORCEHOST 

Tip: If you know the name or IP address of the computer that will 
run the SentinelLM license server, it is recommended that 
you add the environment variable LSFORCEHOST to the 
client computers and set it to this name or address. When 
the Freedom Scientific program starts, it will only search for 
a product license on the specified computer. If you have 
distributed the license over more than one license server 
and you want the program to search for the first available 
token, do not add this environment variable. For more 
information, refer to the System Administrator’s Guide, 
which is a Network Authorization tool that was installed as 
part of the Server component installation.   

Do the following to add the environment variable: 

1. From Windows Explorer, select My Computer. Next, right-
click My Computer and choose Properties.  

2. In the System Properties dialog box, select the Advance 
tab, and choose the Environment Variables button.   

3. Select the New button that appears in the System Variables 
area, and then enter LSFORCEHOST in the Variable name 
field and the server name in the Variable Value field. Click 
OK to close the dialog box and save the changes.  

WYNN Client Installation Process 
WYNN installation is a two-step process. 

• The first step is to install the WYNN application by running the 
Setup.exe file on the client from the WYNN server.   

• Once the application is installed, determine if you want to install 
AT&T Natural Voices. If yes, insert an AT&T Natural Voices 
CD. Install as many of the AT&T Natural Voices as you like.  
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Installing WYNN Wizard or WYNN Reader  

The following describes how to install the network license version 
of WYNN Wizard or WYNN Reader.  

Note: Always install the WYNN application before installing the 
AT&T Natural Voices™ speech software, which is provided 
on separate installation CDs.  

To install the WYNN Wizard or WYNN Reader application: 

1. From the client PC, use Windows Explorer to browse to the 
WYNN setup file using one of the following paths: 

For WYNN Wizard: 

\\fileserver\WYNN4nw\WYNN Wizard Eng\Setup.exe 

Where fileserver is the name of the WYNN file server. 

For WYNN Reader:  

\\fileserver\WYNN4nw\WYNN Reader Eng\Setup.exe 

Where fileserver is the name of the WYNN file server 

2. The WYNN InstallShield wizard window appears.  

Click Next and follow the on-screen instructions.  

3. When installation is complete, the InstallShield Wizard 
Complete window appears.  

Note: For certain installations, such as an upgrade, it may be 
necessary to reboot your PC. Click Yes when prompted if 
this is the case.  

Click Finish.  
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The WYNN application is installed, and the WYNN 
application folder icon appears on your desktop. 

 or       

4. Do one of the following: 

• If you are installing AT&T Natural Voices on this client, 
go to the Installing AT&T Natural Voices section and 
follow the installation procedures.  

• If you are not installing AT&T Natural Voices on this 
client, go to the next client PC, and repeat steps 1 
through 3 to install the WYNN application.  

Installing AT&T Natural Voices 

Note: When performing installation on multiple clients, you may 
want to copy the contents of the AT&T Natural Voices CDs 
to your network server so that you can install the speech 
software remotely onto the client PCs.  

Install the AT&T Natural Voices™ speech software after you finish 
installing the WYNN application. To install AT&T Natural Voices, 
do the following. 

1. Do one of the following:  

• After inserting an AT&T Natural Voices CD into your 
computer’s CD-ROM drive, let the auto-run feature 
start the installation.  

or 

• From the client, browse to the location on the server of 
where you placed the AT&T Natural Voices files, and 
select Setup.exe.  
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2. Follow the on-screen instructions.  

3. Repeat these steps to install additional voices. Remove the 
AT&T Natural Voices CD from your PC when complete.  

4. Go to the next client PC, and repeat steps 1 through 4 of the 
Installing WYNN Wizard or WYNN Reader to install the 
WYNN application on another client PC.  

Note: To select an AT&T Natural Voices speech engine, refer to 
Changing WYNN’s Voice or Language Settings. 
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Getting Started 
This section describes basic tasks that all users can perform to 
start WYNN, open documents using WYNN, and save documents 
using WYNN.    

Starting WYNN 
The first time you start WYNN, you must create a unique user 
name before using the software. Not only does this process create 
your user name, but it also creates your own user folder, which is 
your default folder that stores your documents. The default folder 
uses your user name. For network versions of WYNN, your default 
user folder is stored on the server. 

To start WYNN: 

1. Double-click the WYNN Wizard or WYNN Reader application 
icon that appears on your desktop.   

 

The User Log-In dialog appears.  
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2. Do one of the following: 

• If you already have a user name, select it from the list, 
and click OK.  

The WYNN application starts, and opens the last file 
that was open.  

…OR… 

• If you are a new user: 

1. Type your name in the Please Sign In Here edit box. 

2. Click OK. A confirmation window appears. 

   

3. Click Yes. A process begins that accepts your new 
user name, creates a default folder for your 
documents, and starts the WYNN application.  

4. The WYNN application starts, your user name appears 
in the upper right corner of the WYNN window, and the 
Welcome to WYNN file appears.  
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Multi-User Log In 

If another user wants to log in without quitting WYNN: 

3. Choose Log in Different User from the File menu or click 
on the name in the upper right corner.  

4. The user can then log in, as previously described, and begin 
using WYNN. 

Note: If only one user will be using WYNN on this computer, you 
can skip the log in process. To do this, choose Enable 
Multi-User Logins from the File menu. Enable Multi-User 
Logins should be unchecked. The next time you start 
WYNN, you will not be asked to log in. Choose this 
command again to re-enable multi-user logins. 
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Creating a New Document 
To create a new document: 

5. From the blue File Management toolbar, click the New 
button. 

  

A blank page appears. You can type new text into this 
document, or click the Scan button to add scanned pages to 
it. 

Tip: You can also press CTRL+N to create a new document. 

Note: By default, the maximum number of documents that can be 
open at once is two. If you create a new document while 
the maximum number of documents is already open, 
WYNN asks you to save changes to the least recently 
accessed document and then closes it.  

To change the number of documents you can have open, see the 
Increasing the Number of Open Documents section. 

Opening an Existing WYNN Document 
To open an existing document: 

1. From the blue File Management toolbar, click the Open 
button. 
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The Select a File to Open dialog appears. All WYNN 
formatted files saved in your user folder appear. WYNN files 
use the .WYN and .ARK file extensions. 

   

2. Locate the file on your computer, and then click Open to 
load the file.  

If the file you want to open is not shown in the list, use the 
Look In combo box to locate and select a different folder.  

Opening Other Documents 

To open files saved in file formats other than WYNN’s default 
format: 

1. From the Files of type combo box, choose one of the 
following file formats that can be read by WYNN.  

• Microsoft Word (.doc) files 

• Portable Document Format (.PDF) files – WYNN 
Wizard only 

• Text (.txt) files 

• HTML files 
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• Rich Text Format (.rtf) files 

When you open a PDF file in WYNN, it becomes available 
just as if you had scanned it in.  

When you open other file types, WYNN displays the 
contents of these files in the Text View without any special 
formatting.  

To view these files in their original format, open them in the 
program they are normally associated with. 

Tip: You can also press CTRL+O to open a file. 

Note: By default, the maximum number of documents that can be 
open at once is two. If you create a new document while 
the maximum number of documents is already open, 
WYNN asks you to save changes to the least recently 
accessed document and then closes it.  

 To change the number of documents you can have open, 
see the Increasing the Number of Open Documents 
section. 

Opening Files Using the WYNN User Files 
Shortcut 

After installing WYNN, the WYNN User Files shortcut appears on 
your desktop. It provides fast access to the files in your default 
WYNN folder.  

To open a document using your WYNN Documents shortcut: 

1. From the Windows’ Desktop, double-click the WYNN User 
Files shortcut. 
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The WYNN folder, which contains your personal default 
folder, and WYNN’s Shared file folder appears. Your default 
folder is located in  

C:\Documents and Settings\All Users\Documents\WYNN. 

 

2. Open your default folder to access your saved files.  

Increasing the Number of Open Documents 
By default, WYNN allows a maximum of two documents to be 
open at once. 

To change this setting, do the following: 

1. Click Settings from the WYNN menu bar, and click the 
General Settings command.  
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The General Settings property page appears.  

2. Enter or select a value in the Maximum Number of Open 
Documents combo box in the lower right corner.  
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3. Click the OK button. 

Scanning a Document into WYNN  
The scanning feature allows you to read and work with printed 
materials in WYNN. You can create a new document based on a 
scanned page or insert scanned pages into existing documents. 
You can also replace existing pages with scanned pages. For 
additional scanning information, refer to the Scanning with WYNN 
section. 

Note: You can only scan documents into WYNN Wizard.. 

Scanning a Page and Making a New Document 

To scan a page and create a new document: 

1. Place the page you want to scan facedown on your scanner. 
Refer to your scanner's manual for more information on how 
to begin scanning. 

2. Click the Scan button on the blue File Management toolbar.  

 

WYNN scans the page, recognizes the text, and displays a 
new document containing the text of the page you scanned. 
This is known as Text View. 

Note: If you are scanning a page into an existing document, 
WYNN automatically appends the scanned page to the end 
of the current document. For more information about 
scanning pages into existing documents, see Scanning and 
Inserting a New Page or Scanning and Replacing the 
Current Page.  
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3. To see the original version of the page, click the Exact View 
button. 

 

To return to the text version, click the Text View button.  

  

Scanning and Inserting a New Page 

When scanning a page into an open WYNN document, WYNN  
automatically adds the scanned page to the end of the document.  

To insert the new page in another part of the document, do the 
following: 

1. Click the Open button on the blue File Management toolbar, 
and open the document that you want to add the new page 
to.  

2. Move your cursor to the location where you want to insert 
the page.  

Important: The scanned page appears before the selected page. 
For example, if you want to insert the new page between 
pages 10 and 11, place your cursor on page 11 before 
scanning the page.  

3. Place the page you want to scan facedown on your scanner. 
Refer to your scanner's manual for more information on 
page placement. 

4. From the Scan menu, choose Scan and Insert New Page.  
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WYNN scans the page and recognizes the text.  

WYNN inserts the new page before the page where you 
placed the cursor. 

Scanning and Replacing the Current Page 

To replace a page in a WYNN document with a newly scanned 
page: 

1. Click the Open button on the blue File Management toolbar, 
and open the document that you want to add the new page 
to.  

2. Move your cursor to the page you want to replace. 

3. Place the page you want to scan facedown on your scanner. 
Refer to your scanner's manual for more information on 
page placement. 

4. From the Scan menu, choose Scan and Replace Current 
Page.  
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5. WYNN scans the page and recognizes the text. WYNN 
deletes the page where your cursor is located and replaces 
it with the scanned page. 

Reading a Document 
WYNN can read a document aloud and “spotlight” the spoken 
words as you read along.  

To read a document: 

1. Open a document.  

2. Select a starting point by clicking a word. The spotlight 
appears on that word.  

For example,  

 

3. Click the Read button. 
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WYNN reads the document aloud and moves the spotlight 
along as it reads. In addition, the Read button switches to 
the Pause button.  

4. To stop reading, click the Pause button.  

 

5. To start reading again from the current cursor position, click 
the Read button.  

 

To change the way WYNN pronounces certain words, refer to the 
Adding Words to the Pronunciation Dictionary section. 

Tip: You can also press F2 or choose Start Reading from the 
Tools menu to start reading. 

Switching Between Exact View and Text View 
When you scan a document, the WYNN system creates two 
versions: an exact image view, and a text only view.  

• The exact image view (Exact View) shows the document 
exactly as it appears in the original.  

• The text only view extracts only the text from the scanned 
document. Text Only mode is the default view after scanning a 
document.  



Getting Started 

 

 66   

To switch between Exact View and the Text View: 

1. Click the Exact View button to view the current document in 
its original form, which may be a scanned image, PDF file, 
Microsoft Word document, or any other supported file 
format.  

 

For example: 

 

In Exact View, you can read the text as it appears in its 
original format, or zoom-in to enlarge the entire image (using 
the View menu). If the document was scanned in Black and 
White, you can also change the background color.  
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When in Exact View, this button changes to the Text View 
button. 

2. Click the Text View button only to see the text of the page, 
without formatting, graphics, line art, tables, and columns. 

  

For example: 

 

While in Text View, you can edit the text or use any of 
WYNN's visual modifications from the green toolbar to 
change how the text appears.  
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Opening Multiple Voice Notes and Text Notes 
You can insert Voice Notes and Text Notes throughout a 
document to provide key information, instructions, and questions 
about specific passages of text. You can also insert multiple Text 
and Voice Notes at the same location in a document. When this is 
done, the notes appear side-by-side in Text View mode.  

 

However, in Exact View mode the notes appear as a single Text 
Note or Voice Note icon. 

 



Getting Started 

 

  69  

To determine if one or more notes appear at a particular location 
in a document while using Exact View mode, do the following: 

1. Place your mouse pointer over a Text Note or Voice Note 
icon, and right-click on the icon. A popup menu appears.  

If the Edit Note (select) command appears with a right 
arrow, this indicates the presence of multiple notes. If there 
is only a single note at that particular location, the right arrow 
does not appear.   

 

2. Click the Edit Note (select) command to view, and select a 
specific note.  

The Text Annotation or Voice Annotation dialog appears 
depending on the type of note selected.  

3. Click Stop or Cancel to close the Voice Annotation dialog, 
or click OK to close the Text Annotation dialog.   

4. Repeat steps 1-3 to open more notes.  

For more information, refer to Creating a Text Note and 
Leaving a Voice Note.  
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Changing the Speech Rate 
You can increase or decrease WYNN’s rate of speech to a setting 
that is comfortable for you. There are two ways to do this using 
either the Rate button on the green Reading Styles toolbar to 
quickly change the speech rate, or the Speech Settings 
command on the Settings menu for a more precise speech rate.  

Using the Rate Button  

To change the speech rate: 

1. Click the Next button until the green Reading Styles toolbar 
appears.  

 

2. Click the Rate button. 

 

It uses the following speech rates: 

• 130 words-per-minute (WPM) 

• 160 WPM 

• 190 WPM 

• 220 WPM 

• 250 WPM 

3. Continue to select the Rate button until you are satisfied with 
the speech rate.  
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Using the Speech Settings Command 

To select a more precise speech rate: 

1. On the Settings menu, click Speech Settings.  

The Speech Settings property sheet appears.  

 

2. Select the Rate slider and move it left or right to decrease or 
increase WYNN’s speech speed. The speech rate appears 
in words-per-minute (WPM). 

3. Click the Test button to listen to the new setting.  

4. Repeat steps 2 and 3 until you are satisfied with the speech 
rate.  
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5. Click the OK button to accept the change, or click the 
Cancel button to restore the previous settings.  

Changing Line and Word Spacing 
To enhance readability when in text view, you can change the 
amount of spacing that appears between words and lines in a 
paragraph.  

To increase line spacing: 

1. Click the Next button until the green Reading Styles toolbar 
appears.  

 

2. Click the Line Space button. 

 

The spacing between lines of text increases.  

3. If necessary, continue to click the Line Space button until 
you are comfortable with the spacing. You can cycle through 
six preset line space settings using this button. 

Note: Any changes made to these settings are automatically 
saved upon exiting the application. When you log in again, 
the last used settings are automatically loaded. 

To increase word spacing: 

1. From the green Reading Styles toolbar, click the Word 
Space button.  
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The spacing between words increases. You can cycle 
through six preset word spacing settings. 

2. If necessary, continue to click the Word Space button until 
you are comfortable with the spacing.  

Note: Any changes made to these settings are automatically 
saved upon exiting the application. When you log in again, 
the last used settings are automatically loaded. 

Tip: To make changes to the visual settings beyond what is 
offered on the green Reading Styles toolbar buttons, go to 
Settings, and then choose Visual Settings.  

Saving a Document 
To save a document in WYNN: 

1. From the blue File Management toolbar, click the Save 
button. 

 

If the file is new, the Select a file to Save to dialog appears. 
Enter a file name and click Save.  

If a file with the same name already exists in the selected 
folder, WYNN asks you if you want to overwrite the existing 
file.  

Click the OK button to replace the existing file.  

Click the Cancel button if you do not want to overwrite the 
file. 



Getting Started 

 

 74   

To save a new document, or to save an existing document with a 
new name: 

1. From the blue File Management toolbar, click the Save As 
button.  

 

The Select a file to Save to dialog box appears.  

If you want to save the file in a different format, click the 
Save As Type combo box. This allows other programs, such 
as Microsoft Word, to read this file. 

 

If you want to save the file in a different folder on your PC, 
locate and select the folder using the Save In combo box. 
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2. Enter a file name into the File name edit box, and click the 
Save button. 

 

Changing WYNN’s Voice or Language 
Settings 

WYNN comes with two speech synthesizers, AT&T Natural 
Voices™ and ViaVoice™. If you choose the Typical install, 
ViaVoice is the default synthesizer. You may switch between the 
two synthesizers at any time while using WYNN. 

Note: AT&T Natural Voices are available on separate CDs. After 
installing WYNN, install the AT&T Natural Voices speech 
synthesizers using these CDs. 

To change the synthesizer: 

1. On the Settings menu, click Retrieve Settings.   

The Retrieve Settings dialog appears.  
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2. From the Name column, choose ViaVoice Speech or AT&T 
Natural Voices Speech.  

3. Click the OK button.  

Note: During a Typical software installation, ViaVoice 
automatically installs the operating system’s default 
language and Spanish. Additional ViaVoice languages can 
be installed by reinserting the program CD and performing 
a Modify installation.  

 AT&T Natural Voices are supplied on separate CDs and 
can be installed by inserting a CD and following the on-
screen instructions. 

To change WYNN’s current voice or language: 

1. On the Settings menu, click Speech Settings.  

The Speech Settings property page appears.  
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2. Do one or more of the following: 

If you want to 
change… 

Then click 

Only the voice Make a selection from the Voice list 
box. 

The language 
and voice 

Choose a language from the Language 
list box, and a voice from the Voice list 
box. 

The 
synthesizer, 
language, and 
voice 

Choose a synthesizer from the 
Synthesizer list box, a language from 
the Language list box, and a voice from 
the Voice list box.  

3. Click the Test button to listen to the new settings.  
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If necessary, make adjustments using the Volume, Pitch, 
Rate, and Inflection commands.  

4. Click the OK button to accept the change, or click the 
Cancel button to restore your previous settings.  

Note: Any changes made to the speech settings are automatically 
saved upon exit. When you log in again, your last used 
settings are automatically loaded.  

To save changes to Speech Settings: 

1. On the Settings menu, click Save Settings.  

• The Save Settings dialog appears.  

 

2. Type a file name into the Enter new settings file name edit 
box.  

3. Click the More button, and select the Speech Settings radio 
button. 

4. Click the Save button, and then click Yes to confirm the 
change.  

These settings become the current system settings and remain 
so until you restore or change and save settings again.   
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Getting to Know WYNN 
This section provides a description of various parts of the WYNN 
screen, which includes:  

• The User Interface  

• Toolbars 

• Menu Bars 

WYNN User Interface 
The table that follows the screen graphic explains the major parts 
of the WYNN screen.   
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User 
Interface 
Item 

Description 

1 File Name. The file’s name appears in the 
WYNN title bar.  

2 WYNN Menu Bar. All WYNN commands are 
available using these menus. 

3    WYNN Toolbars. This row of buttons 
contains the common toolbar buttons and the 
current toolbar’s buttons. The primary 
toolbars are the blue File Management 
toolbar, the green Reading Styles toolbar, the 
pink Study Tools toolbar, and the yellow 
Writing Tools toolbar.  

4   Spotlight Text. When in Read mode, the 
cursor position appears as spotlighted text.  

5 Document Work Area. Your document 
appears in this scrollable area.  

6 Cursor and Page Locator. Indicates which 
line the cursor is in, and it indicates which 
page is currently in view.  

7 Read/Write and Text View/Exact View 
Indicator. Shows the document’s current 
editable (Read Only or Write) and viewable 
(Text View or Exact View) status.  

8 User Name. Shows you who is currently 
logged in to the WYNN system.  
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WYNN Toolbars 
WYNN's toolbars provide quick access to many different 
commands. There are four primary toolbars, each with different 
colors and buttons. In addition, there are several buttons available 
on each toolbar: the Next, Read/Pause, Write/Read-Only, Exact 
View/Text View, and Other Doc buttons. Each toolbar is briefly 
described in the following sections. 

Tip: From the Settings menu, choose Custom Toolbar to create 
a customized toolbar with the commands you use most 
often. Refer to the topic Creating a Custom Toolbar for 
more information. 

Common Toolbar Buttons 
The Common Toolbar buttons always appear as the first five 
buttons from left to right on the WYNN screen. Use these buttons 
to: 

• Switch from one toolbar to another 

• Start or stop WYNN from reading aloud 

• Edit a document 

• View a document in its original formatted state or as text 

• Switch between open WYNN documents  
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The following table describes these buttons.  

Button Description 

 
Click the Next button to cycle through 
WYNN's four color-coded toolbars. The 
color of the bar at the top of the button 
indicates which toolbar will display when 
you click the button. The color of the up 
arrow indicates the active toolbar. 

    
When you click Read, WYNN reads the 
document aloud and moves the spotlight 
along as it reads. While WYNN is reading, 
this button changes into the Pause button. 

Click the Pause button to stop reading. 
Click Read again to resume reading from 
the current cursor position. 

    
Click Write if you want to edit or make 
additions to the text of the current 
document. This button is not available in 
Exact View, and changes you make in Text 
View are not visible in Exact View.  

When the document is in Write mode, this 
button changes into the Read Only button. 
Click the Read Only button to return to 
Read-only mode. You cannot write or edit 
text in Read-only mode. 
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Button Description 

    
Click the Exact View button to see the 
current document in its original form, which 
may be a scanned image, PDF file, 
Microsoft Word document, or any other 
supported file format. While in Exact View, 
you can zoom (using the View menu), read 
text, and change text and background 
colors if the document was scanned in 
black and white mode. You cannot make 
any changes to the actual document text. 

When in Exact View, this button changes 
to the Text View button. Click the Text 
View button to see just the text of the 
page, without any formatting, including 
graphics, line art, tables, and columns that 
affect how the page appears. While in Text 
View, you can edit the text or make 
modifications to how the text looks using 
the green toolbar’s Visual settings buttons. 

 
Click the Other Docs button to cycle 
between all currently open documents. The 
maximum number of documents you can 
have open is determined in General 
Settings. 

You can also use the Window menu to 
switch between open documents. Either 
select the document you want to switch to 
from the menu or choose Next Document.
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File Management Buttons 
Use the blue buttons on this toolbar to scan, create, open, close, 
print, and save documents. You can also use this toolbar to 
access WYNN’s document clean-up function and the Internet. 

 

Button Description 

 
Place a page on your scanner and click the 
Scan button to begin scanning. WYNN 
scans the page, recognizes the text, and 
displays it in Text View. You can interrupt 
the scanning process by clicking the 
Cancel button. If you scan additional 
pages, WYNN inserts these new pages 
after the page the last page scanned. 

In order to scan a document directly into 
WYNN, you must use WYNN Wizard and 
have previously installed your scanner. 
You cannot scan documents if you are 
using WYNN Reader or have not installed 
a scanner. 

Tip: To change your scanning and OCR 
preferences, choose Scanning Settings 
from the Settings menu. To use a different 
scanner or driver, choose Scanner 
Selection from the Advanced menu. 
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Button Description 

 
Click the New button to create a new 
WYNN document. You can type new text 
into this document or scan new pages into 
it.  

If you create a new document while the 
maximum number of documents is already 
open, WYNN asks you to save your 
changes to the document you have 
accessed the least recently and then 
closes it. To change the number of 
documents you can have open, choose 
General Settings from the File menu. 

Tip: You can also press CTRL+N to create 
a new document. 

 
Click the Open button to open an existing 
file in WYNN. Locate the file on your 
computer and then click Open to load the 
file. If the file you want to open is not in the 
list, use the Look In combo box to select a 
different folder. 

You can open other types of files using 
either WYNN Wizard or WYNN Reader by 
making a new selection in the Files of Type 
combo box. WYNN can read Microsoft 
Word (.doc) files, text (.txt) files, HTML 
files, and rich text format (.rtf) files. WYNN 
Wizard can also open PDF files. When you 
open a PDF file in WYNN Wizard, it 
becomes available just as if you had 
scanned it in. When you open files of other 
types, WYNN displays the contents of 
these files in the Text View without any 
special formatting. To view these files in 
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Button Description 

their original format, you should open them 
in the program they are normally 
associated with, and then print them to 
WYNN using the Freedom Import Printer 
driver. 

If you create a new document while the 
maximum number of documents is already 
open, WYNN asks you to save your 
changes to the document you have 
accessed the least recently and then 
closes it. To change the number of 
documents you can have open, choose 
General Settings from the File menu. 

Tip: You can also press CTRL+O to open 
a file. 

 
Click the Close button to close the active 
document. If you have made any changes 
or added mark-ups to the document, 
WYNN asks you if you want to save them. 
Click Yes to keep your changes. Click No 
to discard your changes. WYNN 
automatically saves any additional pages 
you have scanned and added to the 
document. 

Tip: You can also press CTRL+W to close 
a document. 

 
Click the Save button to save changes to 
your document. WYNN saves the 
document using the current file name and 
location. 
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Button Description 

 
Click the Save As button to save your 
document with a new file name and/or 
location. After you click this button, enter a 
new name for the file in the File Name edit 
box. You can save the file in a different 
format by making a new selection in the 
Save As Type combo box. This allows 
other programs, such as Microsoft Word, 
to read this file. If you want to save the file 
in a different folder on your PC, select the 
folder in the Save In combo box. 

Click Save to save your document using 
the new name and/or location. If a file with 
the same name already exists in the folder 
you selected, WYNN asks you if you want 
to overwrite the existing file. Click OK to 
replace the existing file. Click Cancel if you 
do not want to overwrite the file.  

 
Click the Print button to print the active 
document. Choose the printer you want to 
use to print the document. Then specify 
which parts of the document you want to 
print and the number of copies you want to 
create. Click OK to begin printing. 

You can choose to print only text that you 
have highlighted in the document by 
selecting the Highlight Text Only radio 
button. You can also choose to print only 
the content of all text notes in the 
document by selecting the Text Notes 
Only radio button. For more information on 
these features, refer to the help topics for 
the Highlight and Note toolbar buttons. 
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Button Description 

Tip: You can also press CTRL+P to print a 
document. 

   

 

The Clean-up feature (also known as 
Document Clean-up) corrects any 
scanning or OCR errors that occur during 
document scanning.  

When you click Clean-up, your scanned 
document appears in a split-screen view 
that shows text in the upper half and the 
scanned image in the lower half.  

Note: Click No Clean-up, and your screen 
returns to its previous whole-screen view 
(text or exact). 

For more information and procedures, see 
Document Clean-up. 

Tip: You can also press SHIFT+F7 to enter 
and exit Document Clean-up 

 
Click the Go To Web button to begin 
browsing the Internet. 

For more information on WYNN's Web 
features, refer to the help topic Browsing 
the Web. For more information on 
configuring your Internet connection and 
changing your Web preferences, refer to 
the help topic Web Settings. 
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Reading Styles Toolbar 
Use the green buttons on this toolbar to change the way 
documents appear visually and audibly in WYNN. You can use 
this toolbar to change the text size, word and line spacing, page 
margins, text and background color combinations, speech rate, 
masking settings, reading mode, and the length of pauses 
between sentences. 

 

Button Description 

 
Click the Size button to increase the size 
of all text in the Text View of the document. 
You can cycle eight preset sizes through 
using this button. The smallest size is 10 
points, while the largest size is 72 points. 

Tip: To specify an exact point size for the 
text, choose Visual Settings from the 
Settings menu. Adjust the Text Size slider 
bar until you find the desired text size and 
then click OK. 
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Button Description 

 
Click the Line Space button to increase 
the amount of space between all lines of 
text in the Text View of the document. You 
can cycle six preset line spacing settings 
through using this button. 

Tip: To manually specify the amount of line 
spacing, choose Visual Settings from the 
Settings menu. Enter the amount of space 
you want between lines of text in the Extra 
Spacing Between Lines edit spin box and 
click OK. 

 
Click the Word Space button to increase 
the amount of space between all words in 
the Text View of the document. You can 
cycle six preset word spacing settings 
through using this button. 

Tip: To manually specify the amount of 
word spacing, choose Visual Settings from 
the Settings menu. Enter the amount of 
space you want between words in the 
Extra Spacing Between Words edit spin 
box and click OK. 
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Button Description 

 
Click the Margins button to increase the 
amount of blank space between the left 
and right edges of the page and the 
document text. You can cycle six preset 
margin settings through using this button. 
Changes to the document margins are only 
visible in Text View. 

To manually specify margins or define 
different margins for the left and right side 
of the page, choose Visual Settings from 
the Settings menu. Enter the new left and 
right margins in the Side Margins area and 
click OK. 

Note: These margins are also used for the 
left and right print margins, but do not 
affect the top and bottom print margins 
specified in the Print Setup dialog box. If 
you select the Use Instead of Side Margin 
Settings check box in the Print Setup 
dialog box, you can enter new left and right 
margins that override those specified in the 
document. 
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Button Description 

 
Click the Color button to cycle through 
preset combinations of text and 
background colors. These color 
combinations have been designed to make 
the page easier to read. 

The available color combinations are 
shown below: 

• Black text on a white background 

• Black text on a rose background 

• Black text on a beige background 

• Black text on a sky blue background 

• White text on a black background 

Tip: To create your own background and 
text color combination, choose Visual 
Settings from the Settings menu. Select a 
new text color and background color from 
the available choices and click OK. 
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Button Description 

 
Click the Mask button to cycle through the 
different masking options. Masking is a 
special tool that shades certain elements 
of the document in order to emphasize the 
current line, sentence, or paragraph. You 
can only use masking in the Text View of a 
document. 

The four masking options are:  

• No masking - No masking is applied to 
the document. 

• Line masking - Shades all text except 
the line where the cursor is currently 
located. 

• Sentence masking - Shades all text 
except the sentence where the cursor is 
currently located. 

• Paragraph masking - Shades all text 
except the paragraph where the cursor 
is currently located. 

Tip: To make the shaded background and 
text lighter or darker, choose Masking from 
the Settings menu.  

Note: You can only change masking 
settings while in Read only mode. When in 
Edit mode, you can only see masked text 
when you press the Read button to read 
the document.  
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Button Description 

 

The Self-Pace button allows you to control 
the pacing of WYNN's speech when 
reading documents. After you click Self-
Pace, choose one of the following reading 
options:  

• Continuous - When you click the Read 
button, the spotlight moves to 
emphasize the text WYNN speaks. 
WYNN continues reading the document 
until you click the Pause button. 

• By Line - When you click the Read 
button, WYNN reads the line of text 
emphasized by the spotlight and then 
stops. Click the Read button again to 
read the next line.  

• By Sentence - When you click the Read 
button, WYNN reads the sentence 
emphasized by the spotlight and then 
stops. Click the Read button again to 
read the next sentence.  

• By Paragraph - When you click the 
Read button, WYNN reads the 
paragraph emphasized by the spotlight 
and then stops. Click the Read button 
again to read the next paragraph. 

Tip: To manually adjust your reading 
preferences, choose General Settings 
from the Settings menu. 
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Button Description 

 
Click the Rate button to increase number 
of words per minute (WPM) WYNN speaks 
when reading text. There are five preset 
speech rate settings that you can cycle 
through using this button: 130, 160, 190, 
220, and 250 WPM. 

Tip: To manually change the speech rate, 
choose Speech Settings from the Settings 
menu. Use the Rate slider to determine 
how many words per minute WYNN 
speaks. 

 
WYNN pauses slightly after each sentence 
just as a natural speaker would. You can 
use the Pause button to increase the 
length of this pause. There are four 
settings that you can cycle through using 
this button, allowing you to set the amount 
of pause from 0 to 1.5 seconds. 

Tip: To manually specify the length WYNN 
should pause between sentences, choose 
Speech Settings from the Settings menu 
and make a new selection in the Extra 
Pause After Each Sentence combo box. 
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Study Tools Toolbar 
The pink buttons on this toolbar allow you to access the basic and 
standard talking dictionaries, spell words audibly, divide words into 
syllables, highlight text, add bookmarks, view a list of highlighted 
or bookmarked words, and create text and voice notes. 

 

Button Description 

 
WYNN includes a talking dictionary that 
lets you look up definitions and synonyms 
for words in your document. Click a word 
and then click the Dictionary button to 
view the word's dictionary entry. When you 
click Dictionary, you can choose to look 
up the word using the Standard dictionary 
or the Basic dictionary. The Standard 
dictionary is 7th-8th grade level while the 
Basic dictionary is 5th grade level. 

The dictionary entry for the selected word 
displays as shown below. When you finish 
working with the dictionary, click Close to 
return to your document.  
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Button Description 

 
WYNN can spell words that may be difficult 
to read.  

To spell a word out loud: 

1. Click the word and then click the 
Spell button. 
 
WYNN displays the word and its 
spelling. WYNN then reads the word, 
reads and highlights each letter, and 
reads the word again.  

To read and spell the word again: 

1. Click Repeat.  

To return to your document: 

1. Click Close. 

This button is not available if you have 
cleared the Text check box in the Speak 
What? area of the Speech Settings dialog 
box. 

 
You can use WYNN to divide words into 
individual syllables and display the word's 
phonetic spelling. To see the syllables and 
the phonetic spelling of a word, click the 
word and then click the Syllables button. 
You can click Read Word to if you want 
WYNN to speak the word aloud. Click 
Read Syllables to have WYNN read each 
individual syllable separately. Click Close 
when you are finished to return to your 
document. 
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Button Description 

 
WYNN allows you to indicate important 
passages or key words in your document 
just as you would highlight text in a book. 

To highlight text in your document:  

Click the Highlight button and choose a 
highlight color from the list. Your mouse 
pointer changes into a highlighter pen.  

Click and drag the highlighter pen over text 
you want to highlight. WYNN highlights the 
text using the color you selected. You can 
highlight a single word by clicking it. 

Click the Highlight button again when you 
are done highlighting text to return the 
cursor to normal.  

To erase highlighting, click the Highlight 
button and then select the eraser at the 
bottom of the list. Your mouse pointer 
changes into a pencil eraser. Click and 
drag the eraser over the highlighting you 
want to remove. You can erase the 
highlighting for an individual word by 
clicking the word. 

Tip: You can search for highlighted text 
using the Find toolbar button, or create a 
list of highlighted text with the Lists toolbar 
button. To print out just the text you 
highlighted in the document, click the Print 
button and select the Highlight Text Only 
radio button. 
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Button Description 

 
WYNN allows you to create a new 
document containing text you have 
highlighted or bookmarked. You can use 
this feature to make lists of topic 
sentences, vocabulary words, useful facts, 
and more. 

To create a list, click the Lists button and 
choose the type of list you want to create 
and how you want to sort it: 

• By Highlight Color - Creates a list of all 
highlighted words or phrases. Text 
highlighted in green appears first in the 
list, text highlighted blue appears 
second, and text highlighted in magenta 
appears last. This choice is useful for 
categorizing information. 

• By Highlight Order - Creates a list of all 
highlighted words or phrases in the 
order they appear in the original 
document. This choice is useful for 
creating study guides with key points 
and supporting points. 

• By Bookmark Type - Creates a list of all 
bookmarked words or phrases from the 
original document. WYNN sorts the text 
into groups separated by bookmark 
type. 

• By Bookmark Order - Creates a list of 
all bookmarked words or phrases 
arranged in the order they appear in the 
original document 

After selecting, WYNN creates a new 
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Button Description 

document containing the highlighted or 
bookmarked text. If you have more than 
the maximum number of documents open, 
WYNN asks you to save your changes to 
the document you have accessed the least 
recently and then closes it. 

 
WYNN lets you bookmark important 
passages of text in a document for quick 
reference. When you choose a bookmark, 
a beginning and ending bookmark will 
appear around the word where the cursor 
is located. To bookmark a phrase, first 
select the text you wish to bookmark, then 
choose your bookmark from the Bookmark 
button.   

To erase a bookmark, click the Bookmark 
button and select the eraser at the bottom 
of the list. Your mouse pointer changes 
into a pencil eraser. Click and drag the 
eraser over the bookmarked text. 

Tip: You can search for bookmarks using 
the Find toolbar button, or create a list of 
bookmarked text with the Lists toolbar 
button. 
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Button Description 

 
WYNN allows you to add notes to any 
location in your document. Teachers can 
create notes containing messages, 
questions, or assignments for students. 
Students can use notes to answer the 
teacher's questions, create reminders, or 
ask questions about the text. An icon 
appears where the note is located. To read 
the note, double-click the icon. To erase a 
note, put the cursor to the right of the Note 
icon and press the Backspace key on your 
keyboard. 

Tip: You can search for notes in the 
document by using the Find toolbar button. 
When you print your document, all your 
notes are printed on a separate page with 
the heading Text Notes. To print just the 
notes contained in your document, click 
the Print button and select the Text Notes 
Only radio button. 
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Button Description 

 
Voice Notes are useful for those with 
stronger auditory than visual processing 
skills. This feature allows you to use the 
microphone to record a spoken message. 
Teachers can create Voice Notes 
containing questions, messages, or 
assignments for students. Students can 
use Voice Notes to record answers to the 
teacher's questions, create reminders, 
summarize or paraphrase, or ask 
questions about the text. An icon appears 
where the Voice Note is located. To listen 
to the note, double-click the icon. To erase 
a note, put the cursor to the right of the 
Note icon and press the Backspace key on 
your keyboard. 

Tip: You can search for Voice Notes in the 
document by using the Find toolbar button. 

 

Writing Tools Toolbar 
Use the yellow buttons on this toolbar to cut and paste text, apply 
bold, italic, and underline to text, find text in the document, create 
and work with an outline, enable/disable Word Prediction, check 
for homophones, and check your spelling. 
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Button Description 

 
The Cut/Paste button allows you to cut, 
copy, and paste text. You must enter Write 
mode using the Write toolbar button before 
you can cut or paste text. 

Tip: You can also press CTRL+C to copy, 
CTRL+X to cut, and CTRL+V to paste, or 
you can choose these options from the 
Edit menu. 

Tip: You can paste text from WYNN into 
other applications, such as Microsoft Word. 
You can also paste text from other 
applications into WYNN. Use the copy, cut, 
and paste commands in the other 
applications just as you would use them in 
WYNN. These commands usually appear 
on the application's Edit menu. 

 
The Style button allows you to apply bold, 
italics, or underline to text in your 
document. While in Write mode, click to 
place your insertion point within a word or 
select a range of text. Click the Style 
button and choose Bold, Italic, or 
Underline. WYNN then applies the 
formatting to the word or selected text.  

Tip: Standard Windows commands will 
also work for these functions: Ctrl B to 
choose Bold, CTRL I to add italics, and 
CTRL U to underline text. 
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Button Description 

 
Use the Find button to search for text or 
mark-ups in the active document. If you 
search for text, you can replace it with new 
text, if necessary. When you click the Find 
button, you can choose between two 
options. Choose Text to search for words 
and phrases. Choose Mark-Up to search 
for highlighting, bookmarks, text notes, and 
voice notes. 

 
Click the Go To button to move to a 
specific page in your document. When you 
click Go To, a dialog box displays. Enter 
the page number of the page you want 
move to and click the Go button. If you 
only want to move forward or back one 
page in the document, use the Next Page 
and Previous Page buttons. 

Tip: You can also press CTRL+G or 
choose Go To Page from the Edit menu to 
perform this command. 

 
Outlines can help you organize the topics 
and supporting points of your documents. 
You can use outlines to plan the 
organization of research papers, 
summarize study materials, create plots for 
stories, and more. 
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Button Description 

 
Use the Adjust button to make adjustments 
to an outline you created using the 
Outlines toolbar button. This button is only 
available when you are creating an outline. 
Move your cursor to a line in your outline 
and click the Adjust button. 

After you click Adjust, choose one of the 
following options: 

• Move Backward - Increases the outline 
level of the line and all its sub-items.  

• Move Forward - Decreases the outline 
level of the line and all its sub-items.  

• Move Up - Moves the line and all its 
sub-items up by one-step within the 
current outline level.  

• Move Down - Moves the line and all its 
sub-items down by one-step within the 
current outline level.  

Refer to the help topic Outlines for more 
information on outline levels and creating 
outlines in WYNN. If you need additional 
assistance with outlines, refer to the 
Outline Tutorial.  

Tip: You can also use the following 
shortcut keys to adjust the outline: move 
forward (TAB), move backward 
(SHIFT+TAB), move up (ALT+UP 
ARROW), and move down (ALT+ DOWN 
ARROW). 
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Button Description 

    
Click the Predict button to activate WYNN's 
Word Prediction feature. Word prediction 
helps you write by making spelling 
suggestions and anticipating the next word 
you are going to type. This feature can 
help you with spelling, grammar, and 
formulating sentences. 

 
When Word Prediction is active, click the 
Speak List button to have WYNN read the 
list of suggested words. This button is 
unavailable if you are not using Word 
Prediction. For more information on the 
Word Prediction feature, refer to the help 
topic Predict. 

 
A homophone is two or more words that 
are pronounced alike, but have different 
meanings and often-different spellings. 

 
Click the Spell Check button to check your 
document for spelling errors. If WYNN 
finds any misspelled words, a dialog box 
appears that allows you to correct the 
mistake.  

Tip: F7 also starts the Spell Check 
process. 
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Web Toolbar 
The Web toolbar only displays when you are browsing the Web in 
WYNN. To display the Web toolbar, click the Go To Web button 
on the File Management toolbar. The following describes each 
button on this toolbar.  

 

Button Description 

 
Click the Back button to return to pages 
you have previously visited during the 
current session. 

 
Click the Forward button to move forward 
through pages you have already visited 
during the current session. You can only 
use this button if you have already clicked 
the Back button. 

 
Click the Stop button to stop the current 
page from loading completely. This button 
is useful if a particular Web page is taking 
a long time to load or if you accidentally 
open the wrong page. 

 
Click the Refresh button to reload the 
current page. Some pages may need to be 
refreshed in order to display recent 
updates. Refreshing may also help correct 
errors if a page does not display properly. 
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Button Description 

 
Click the Search button to search the Web 
for a particular subject or topic. Enter the 
topic you want to search for and then click 
the Search Now button. WYNN submits 
your search to Google.com and then 
displays the results on your screen. 

 
Click the Go To Page button to visit a 
specific Web address. Enter the Web 
address of the page you want to visit and 
click Go.  

 
Click Favorites to add a Web page to your 
list of favorites, organize your favorites, or 
visit pages in your favorites list.  

 
Click the History button to see a list of 
Web pages you have visited in the past. 
From the context menu, choose the day 
you want to view history for. A sub-menu 
that lists all Web sites you have visited on 
that day appears in the upper left corner of 
the window. Click a Web site to display 
another sub-menu containing a list of all 
pages on the Web site that you visited. 
Click a Web page name to open the page. 

 
Click the Home button to return to your 
home page.  



Getting to Know WYNN 

 

  109  

Button Description 

 
Click the WebMask button to enable or 
disable the WebMasking feature. 
WebMasking shades distracting images 
and reduces visual clutter so you can focus 
on a specific element of the Web page, 
such as a paragraph or link. You can focus 
on a page element by clicking near it.  

 
Click the Close Web button when you are 
finished browsing the Web. WYNN closes 
the current Web page and displays the last 
document you were working on. 

 

 WYNN Menu Bars 
The menu bar allows you to access every function and command 
in WYNN. The menu bar contains ten menus. The following table 
describes each menu.  

Tip: If you wish to have the items on the menus speak, go to the 
Settings menu, then Speech Settings. From the Speak What 
option, check Menus and Dialogs.   

Button Description 

File 
The File menu allows you to manage files, 
print documents, view document 
properties, and more. 
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Button Description 

Edit 

The Edit menu allows you to switch 
between read-only and edit modes, 
cut/copy/paste and select text, apply 
character formatting, find/replace text and 
mark-ups, create outlines, and work with 
page numbering and order. 

Scan 
The Scan menu allows you to scan 
documents, change scanning speed, and 
control some basic scanning settings.  

View 

Use the View menu to show or hide certain 
elements of the WYNN application. You 
can also use this menu to switch to and 
magnify the Exact View for scanned 
documents. 

Tools 

The Tools menu contains reading 
commands, study tools like a spell 
checker, dictionary/thesaurus, and 
homophone checker, and mark-up tools 
like highlighting and bookmarks.  

Advanced 

The Advanced menu allows you to access 
a number of special commands and 
features like Teacher Lockout, the 
Pronunciation Dictionary, and Word 
Prediction controls. You can also use this 
menu to launch external applications and 
select a scanner.  
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Button Description 

Settings 

The commands available in the Settings 
menu allow you to customize WYNN. You 
can change visual settings, speech 
preferences, email and Web settings, 
masking, word prediction, differential 
coloring, and more. You can also 
customize WYNN's toolbars.  

Web 

The Web menu provides access to 
commands you can use to browse the 
Internet. These commands are similar to 
those found in popular Internet browser 
software and include Web navigation, 
favorites, history, and a refresh command. 

Windows 
The Windows menu allows you to switch 
between documents currently open in 
WYNN. 

Help The Help menu lets you view WYNN's 
online help system. 
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Teacher Exercise Guide 
This section describes tasks that teachers can use to configure 
WYNN for overall operation. It also provides exercises that 
teachers can create or demonstrate for students.    

Scanning with WYNN 
The following links describe what you should know before 
scanning a document as described in the Scanning a Document 
into WYNN section.  

• Before You Scan 

• Color Scanning 

• Scanning Multiple Pages 

• Scanning Text without Charts or Tables 

• Scanning Tables 

• Scanning Difficult Text 

Before You Scan 

Before you scan a document, make sure that: 

• You are using WYNN Wizard. WYNN Reader does not have 
scanning capability. 

• Your scanner is turned on and connected to your computer.   

• The drivers for your scanner are installed on your computer. 

• WYNN is running. 

• The blue File Management toolbar is active. 
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Important: Always use the blue Scan button –  – when 
scanning with WYNN. The Scan button appears on the 
blue File Management toolbar. If there is a Scan button 
located on your scanner, do not use this button to Scan 
documents into WYNN, even if instructed to do so in your 
scanner’s manual.   

 If your scanner has a Scan button, never use it when 
scanning with WYNN. 

Note: Some scanners use the back of the scanner glass for page 
placement for the top of the page. Others use the front of 
the scanner glass. Each scanner has an arrow or some 
other mark to show you where the top of the page should 
be; make sure you are familiar with your scanner’s 
orientation. 

Color Scanning 

WYNN scans in color by default.; however, color scanning takes 
longer than black and white scanning.  

To enable black and white  scanning:  

• From the Scan menu, click the Color Scanning command.  

The checkmark no longer appears next to the command. All 
future scans use the black and white mode until you change 
this setting. 

To re-enable color scanning: 

• From the Scan menu, click the Color Scanning command.  

A checkmark no longer appears next to the command.  
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Scanning Multiple Pages 

There are three parts to the scanning process: scanning the page 
image, processing the image, and recognizing the image, or 
converting it to electronic text . WYNN normally scans a page, 
then immediately processes and recognizes it before moving on to 
the next page. When scanning a document with multiple pages, 
Batch Scanning allows you to separate these processes; all the 
scanning is done at one time, followed by the processing and 
recognition of the pages. The WYNN program can scan multiple 
pages using the following scanning modes: 

• Large Batch Scanning 

• Express Batch Scanning 

• 2-Page Scanning 

Large Batch Scanning 

Use Large Batch scanning mode to scan a large group of pages, 
such as a book, quickly and efficiently. This type of scanning 
requires your participation to turn the pages, but processing and 
recognition—the lengthier tasks—are done by your computer in a 
batch without your active participation.    

To enable large batch scanning: 

1. From the Settings menu, select the Scanning Settings 
command. 

The Scanning Settings property page appears.  
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2. From the Scanning Mode list box, select Large Batch. 

3. Click OK.  

WYNN is now configured for large batch scanning mode.  

Scanning in Large Batch Mode: 

1. During scanning, the Batch dialog box appears after a page 
is scanned.  
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2. Select one of the following large batch options: 

If… Then click 

You want to 
scan 
another 
page 

Scan Another Page 

You are 
finished 

Done scanning 

You want to 
pause 
scanning 

Suspend scanning 

You want to 
cancel 
scanning 

Cancel Scanning 

3. When scanning is complete, WYNN starts the processing 
and recognition tasks. The newly scanned pages appear in 
the open document.  

Note: Any changes made to your scanning settings are 
automatically saved upon exit.   
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Express Batch Scanning 

Express Batch scanning is an even faster way to scan multiple 
pages, but it also requires that you react quickly. This scanning 
mode skips the page-turning prompts, and requires that you follow 
the scanning process so that you know when to turn the page for 
the next scan.  

To enable express batch scanning: 

1. From the Settings menu, select the Scanning Settings 
command. 

The Scanning Settings property page appears.  
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2. With Express Batch Scanning enabled, as soon as the 
scanner head returns to its starting position, it starts 
scanning again. To set an additional delay, from the 
Express Batch Delay list box, select a value from 1 to 25 
seconds as the delay that occurs between scanned pages. 
Otherwise, as soon as the scanner head returns to its 
starting position, it starts scanning again. 

3. From the Scanning Mode list box, select Express Batch. 

4. Click OK.  

WYNN is now configured for express batch scanning mode.  

Note: Any changes made in  your Scanning Settings property 
page are automatically saved upon exit.  

Scanning in Express Batch Mode: 

Note: If you are using an HP ScanJet 5500 series scanner, make 
the following adjustments in WYNN before scanning. 
Otherwise, you may experience problems when scanning 
in Express Batch mode.  

 From the Advanced menu, select the Scanner Selection 
command.  

 In the Scanner Selection dialog, select the HP ScanJet 
5500C as your scanner, choose the three TWAIN 
Properties settings, and then click OK. 

1. During scanning, you must watch and listen for when the 
scanner head reaches the bottom of the glass and returns to 
the top. In those few seconds, you must turn the page.   

2. After scanning all the pages in the batch, press the Cancel 
Scan button.  
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The Batch scan dialog box appears.  

3. Choose Done scanning.  

 

When scanning is complete, WYNN starts the processing 
and recognition tasks. The newly scanned pages appear in 
the open document. 

2-Page Scanning  

WYNN’s 2-Page scanning mode is intended for physically smaller 
documents, such as paperback books, in which both pages of the 
open book fit on the scanner at the same time. With 2-page 
scanning enabled, the scanner sees these as one page, but 
WYNN processes them as two separate pages.   
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To enable two-page scanning: 

1. From the Scan menu, click the 2-page Scanning command.  

 

A checkmark appears next to the command. All future scans 
made during this session use the lengthy color-scanning 
mode until it is turned off.  

To disable two-page scanning: 

1. From the Scan menu, click the 2-page Scanning command.  

A checkmark no longer appears next to the command.  

Scanning Text without Charts or Pictures 

You can expedite the scanning process by configuring WYNN to 
discard the Exact View of the pages. However, WYNN’s 
Document Clean-up function requires that the Exact View be able 
to compare the original image with the recognized text. This can 
be of great benefit in cleaning up documents that may have made 
errors during the recognition process. See Correcting Text in a 
Scanned Document for more information about this feature.  

To do this: 

1. From the Settings menu, select the Scanning Settings 
command. 
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The Scanning Settings property page appears. 

 

2. Uncheck the Keep Exact View command.  

3. Click OK.  

Scanning Tables 

By default, WYNN automatically determines where the columns 
are on each page, then displays the columns in Text View in the 
proper order. However, when you scan a table, you do not want 
pages treated as though they have columns. You want WYNN to 
read all the way across the first line of the table, then the second 
line, and so on. 

To do this, turn off WYNN’s Recognize Columns setting when 
scanning tables.   

1. From the Settings menu, select the Scanning Settings 
command. 
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The Scanning Settings property page appears. 

 

2. Uncheck the Recognize Columns command.  

3. Click the OK button.  

Scanning Difficult Text 

When scanning difficult text, such as very small text, unusual 
fonts, or unusual layouts, use WYNN’s Most Accurate Scanning 
mode. 

Note: This method of scanning may take longer than WYNN’s 
default settings.  

To enable Most Accurate Scanning mode: 

• From the Scan menu, click the Most Accurate Scanning 
command.  

A checkmark appears next to the command.  
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To disable accurate scanning mode: 

• From the Scan menu, click the Most Accurate Scanning 
command.  

A checkmark no longer appears next to the command.  

Rearranging Text in a Scanned Document 
Dynamic Zoning allows you to define your own reading order on a 
scanned page. Dynamic Zoning can also be used to avoid 
recognition errors from graphics, or to exclude the speaking of 
headers, footers, or other unwanted text.   

Note: Use the Dynamic Zoning feature before using the Document 
Clean-up feature. 

1. From the Advanced menu, choose Dynamic Zoning, and 
then Enable Dynamic Zoning.   

The scanned image appears in Exact View mode with all 
current reading zones outlined in blue.  
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Take a moment to study the document and determine how 
you want to redefine reading zones.  

2. Select the Re-Define button to remove the current zone 
indicators so that you can redraw the zones in the correct 
order.  

  

3. Use your mouse to draw a box around each block of text you 
wish to have spoken. A red outline appears around 
redefined zones. 
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The reading order is determined by the order in which you 
define the zones. Do not draw zones around pictures or 
other graphic images that cannot be spoken. 

Note: If you make a mistake while redefining zones, click the 
Revert button to return to the original zones on that page. 
You may also use Erase to erase all zones created and 
start over again.  

   

4. To continue changing zones on other pages of the scanned 
document, press the Page Down key until the next page 
appears. (The message “Loading Page” appears in the 
lower left corner.) Again, the existing zones appear in blue.  
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5. Repeat step 2 and 3 to redefine the reading order for the 
next page. Repeat this process for each page you wish to 
re-zone. 

6. After defining new zones on all pages that apply, select the 
Re-Process button. This tells WYNN to refresh the 
document using the newly defined zoning order.  

 

Correcting Text in a Scanned Document  
Use the Document Clean-up feature to correct any scanning or 
recognition errors that occurred during document scanning. This 
feature displays both the Exact View and the Text View of the 
document so you can compare them. This allows you to easily 
correct errors so that the text is spoken correctly in either view.  

To correct the text of a scanned document: 

1. From the Advanced menu, choose Document Clean-up.  

WYNN displays the Text View of the document in the top 
half of the window, and the Exact View of the document in 
the bottom half of the window.  
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2. Scroll through the Text View, and look for OCR errors.  

3. Click an incorrect word you find in the Text View.  

WYNN moves your insertion point to the word. A pink 
rectangle appears around the word in the Text View 
window, while the same word appears as highlighted text in 
the Exact View window.  

Note: You can also click a word in the Exact View to place a pink 
rectangle around the location where the word appears in 
the Text View. 

4. Correct any spelling or scanning errors.   
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Important: When correcting errors, do not delete the whole word. 
First, type in the corrections, and then delete the errors. 
Deleting the entire word prior to inserting corrections 
erases the link that WYNN uses to connect the word in the 
Text View and Exact View. In this case, WYNN no longer 
spotlights the word in Exact View when reading.  

5. Continue searching the Text View window for OCR errors. 
When you are finished, choose Document Clean-up from 
the Advanced menu. 

6. Click the Save button from the blue File Management 
toolbar to save your corrections. 

Document Clean-up Guidelines 

Keep the following items in mind when using the Document 
Clean-up feature.  

• Use Exact View to reference original text. 

• Make corrections in Text View. 

• Keep the link between Text View and Exact View by correcting 
parts of a word at a time until the entire word is corrected. If you 
delete an entire word in Text View, it breaks the link between 
Text View and Exact View. The location in Exact View is no 
longer spotlighted.  

• After closing the Document Clean-up feature, run Spell Check, 
in Text View mode, to catch random characters or mistaken 
words. 

Guidelines for Increased Scanning Accuracy 
• Use OCR Correction (Advanced menu) to catch repeated 

recognition errors. 

• Modify Scanning Contrast (Settings menu, Scanning 
Settings command) for light text or dark paper.  
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• Use Dynamic Zoning to eliminate recognition of changes or 
graphics. 

Scanning and Reading Other Languages in 
WYNN 

WYNN can scan and read in several languages in addition to 
English. The ability to correctly scan text in other languages is 
automatically set during the installation process. 

The speech synthesizers included with WYNN have the capability 
to pronounce text in U.S. English, Spanish, French, Italian, 
Brazilian, German, and British English. Using the “Typical” install, 
WYNN automatically installs U.S. English and Spanish as choices, 
with U.S. English as the default.  

To install any of the other languages, choose “Custom” install. You 
may also choose to add any, or all, of the other languages after 
the initial installation has been complete by re-inserting the 
program CD and following the prompts. 

Scanning Documents in a Language other than 
U.S. English 

To change scanning language settings: 

1. On the Settings menu, click the Scanning Settings 
command. 
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The Scanning Settings property page appears.  

2. Change the Recognition Language command to match the 
language of the document you are scanning. 

This configures WYNN to correctly recognize any special 
characters of that language.  
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Reading Documents in a Language other than 
U.S. English: 

To change speech language settings, refer to the Changing 
WYNN’s Voice or Language Settings section.    

Tip: When you exit WYNN, your current scanning and speech 
settings become your default settings, which are used next 
time you log in. 

Selecting the Correct Word Using 
Homophones 

Being able to identify which word to use in a sentence can build a 
student’s vocabulary. The following task provides an overview for 
using the Homophones function for a student exercise.  

1. Create or provide a passage of text that contains 
homophones.  

You can do this by scanning text directly into WYNN, or by 
providing an external document (such as a Word, PDF, text, 
RTF, or HTML file) that WYNN can open.   

2. Ask the student to open the document, and run the 
Homophones function using the Homophones button on the 
yellow Writing Tools toolbar.  

 

3. Make sure that the student reads each definition and selects 
the correct word as used in the sentence. 
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Broadcasting Documents and Settings 
Broadcasting is a powerful function that allows teachers to 
broadcast WYNN files and settings to a classroom of users. You 
can log on to a single computer and download files and settings 
for just the user accounts on a specific computer, or, if using the 
network version of WYNN, you can broadcast files and settings to 
all users on the network, regardless of which computer they use to 
log in.  

Note: To broadcast documents or settings, you must sign in to 
WYNN using the login name Shared. This name does not 
appear on the list of user names, so you must manually 
enter it each time. The Broadcast Documents and 
Broadcast Settings commands are not available unless you 
log in with the name Shared. 

Broadcasting Documents to Other Users 

You can send documents to other WYNN users. This allows you to 
copy documents located in the Docs folder for the login name 
Shared to the Docs folder that belongs to each user.  

To broadcast documents to other users: 

1. If you are not already logged in as Shared, from the File 
menu, choose Log In Different User. 
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2. Sign in using the login name Shared and click OK. 

 

3. From the Advanced menu, choose Broadcast Documents.  

 

4. Select the document you want to broadcast. Hold down 
CTRL and click to select multiple documents. You can only 
broadcast documents stored in WYNN's Shared\Docs folder.  

Note: You can only broadcast closed documents. If the document 
is open, you must close it first before you can broadcast it. 
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5. Click Broadcast to send the documents to all other users. 

 

Broadcasting Settings to Other Users 

WYNN allows you to send your abbreviation definitions, OCR 
corrections, personal spell check dictionary, pronunciation 
dictionary, word prediction lists, custom toolbars, and so on to all 
other users.  

To broadcast customized or modified settings to other users: 

1. If you are not already logged in as Shared, from the File 
menu, choose Log In Different User. 
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2. Sign in using the login name Shared and click OK. 

 

3. From the Advanced menu, choose Broadcast Settings. 
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4. Select the type of settings you want to broadcast. Hold down 
CTRL and click to select multiple types of settings. You can 
only broadcast settings associated with the user name 
Shared. 

 

5. Click Broadcast to send the settings to all other users. 
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Adding Words to the Pronunciation 
Dictionary 

The Pronunciation Dictionary allows you to define how WYNN 
pronounces words that it reads aloud. The AT&T Natural Voices 
and ViaVoice speech synthesizers do a good job of pronouncing 
words through a combination of text-to-speech programming and 
internal dictionaries. However, there may be some words that the 
synthesizer does not pronounce properly. These words vary from 
synthesizer to synthesizer. Using WYNN's Pronunciation 
Dictionary, you can change the pronunciation of any word. 

To add a new word, phrase, or acronym to the Wynn 
pronunciation dictionary: 

1. On the Advanced menu, click Pronunciation Dictionary. 

The Pronunciation Dictionary dialog appears.  

 

2. Scroll through the Word List to make sure that the new text 
does not appear in the pronunciation dictionary.  
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3. Type the new word into the Word edit box.  

4. Enter a pronunciation for the word in the Pronunciation edit 
box.  

Try spelling the word phonetically using simple combinations 
of consonants and vowels. Use spaces to separate letters if 
you want WYNN to say the name of the letter rather than 
make the associated sound (this is useful for acronyms). 

Tip: You can also use spaces to isolate phonetic sounds created 
by two or more letters. The synthesizer clearly pronounces 
these sounds when reading the word. 

5. Click Test to hear the new pronunciation of the word. 
Continue adjusting the pronunciation until you achieve the 
desired pronunciation. 

6. When you are satisfied with the pronunciation, click the Add 
button to update the Pronunciation Dictionary.  

7. Click Close to return to the active document. 

Configuring Word Prediction  
The Word Prediction feature is useful for people who have 
difficulty coming up with words or spelling while writing. It offers 
suggestions that complete the word the student is typing, and it 
proposes the next word for the student to type. This allows your 
students to focus on getting their ideas “on paper,” regardless of 
their ability to spell. 
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Using the control tabs of WYNN’s Word Prediction Teacher 
Controls, you can:  

• Customize word and phrase suggestions provided by the Word 
Prediction feature 

• Increase or decrease the Word Prediction’s word list by adding 
words and phrases 

• Define phonetic spelling information  

• Choose writing styles, and more 

Word Prediction Learning Text Tab 

Use the Word Prediction Learning Text tab to have the word 
prediction system learn new words from a file or the current 
document. You can also have WYNN learn words as you type. 

To analyze and learn vocabulary patterns from a plain text file or 
the current document: 
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1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Predication Learning Text tab. 

 

3. Do one of the following: 

• If you want WYNN to learn from the current document, 
click the Current Document button.  

…OR… 

• If you want WYNN to learn vocabulary patterns from a 
plain text file, click the TextFile button. Locate the file, 
select it, and click Open. 

4. WYNN adds new phrases from the current document or text 
file to the word prediction list. 

To analyze and learn vocabulary patterns as you type: 
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1. From the Advanced menu, choose Word Prediction Teacher 
Controls. 

2. Click the Word Predication Learning Text tab. 

3. Select the Automatically Learn as I Type check box. 

4. If you want WYNN to check the spelling of each word or 
phrase before adding it to the word prediction list, select the 
Spell Check Each Word Before Learning check box. 

5. Click OK.  

Word Prediction Edit List Tab 

As you type, new words and phrases are added to the word 
prediction list. 

The Word Prediction Edit List tab allows you to select a different 
size word list or add words to the list for the current user.  
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Tip: You can search for words already in the word prediction list. 
To do this, enter the word and then click Search. WYNN 
displays a list of phrases containing the word. 

Adding Words/Phrases to the List 

To add a word or phrase to the word prediction list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Edit List tab. 

3. Click the Add a Word button. 

4. Type the word you want to add to the word prediction list. 

5. Specify whether the word is a verb, noun, or other by 
selecting the corresponding radio button. 

WYNN automatically displays some suggestions based on 
the spelling of the word and the word's part of speech.  

• For verbs, WYNN suggests how the word appears 
when used in the various tenses.  

• For nouns, WYNN suggests how the word is pluralized 
and how it is used in different situations.  

• For other words, WYNN wants you to enter several  
phrases where the word is used in context.  

Review the suggestions and correct any words that do not 
reflect proper usage. 

6. Click the OK button to add the word. 
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Restoring the Default List  

To remove all changes made to your personal word prediction list 
and to restore the default list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Edit List tab. 

3. Click the Clear All Personal Learned Text button. 

4. Click OK to restore the default word list.  

Click Cancel to keep your personalized word list. 

Word Prediction Phonetics 

Use the Word Prediction Phonetics tab to add, modify, or delete 
phonetic associations. This feature allows you to customize Word 
Prediction so that it corrects commonly misspelled phonetic 
sounds. For example, phonetic associations allow WYNN to 
recognize f as a possible misspelling of the sound created by the 
letters ph. 
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Adding Phonetic Associations 

To add a new phonetic association to the word prediction list: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 

3. In the Phonetic edit box, type the incorrect phonetic spelling 
of the sound. 

4. Type a comma. 

5. Type the correct spelling of the sound.  

Example: To recognize f as a possible misspelling of the 
sound created by the letters ph, type "f,ph" in the Phonetic 
edit box. This creates a phonetic association between f and 
ph. 

6. Click the Add button. 
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7. Click the OK button to save your changes. 

Modifying Phonetic Associations 

To modify an existing phonetic association: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 

3. Select the phonetic association you want to modify in the 
List of Phonetic Associations. 

4. In the Phonetic edit box, change the phonetic association. 

5. Click the Update button. 

6. Click the OK button to save your changes. 

Deleting Phonetic Associations 

To delete phonetic associations: 

1. From the Advanced menu, choose Word Prediction 
Teacher Controls. 

2. Click the Word Prediction Phonetics tab. 

3. Locate the phonetic association in the List of Phonetic 
Associations and select it.  

4. Click the Delete button. 
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Tip: If you do not want to delete a phonetic association, yet you do 
not want it to apply to the current document, clear the 
adjacent check box. You can restore the association at any 
time by selecting the check box again. Use the Clear All 
and Select All buttons to quickly select or clear all the 
check boxes. 

Word Prediction List 

The Word Prediction Lists tab allows you to select which writing 
styles you want word prediction to use. These vocabulary 
categories are from detailed linguistic research and analysis of 
written and spoken English words.   

To change the writing styles WYNN uses when predicting words 
and phrases: 

1. From the Advanced menu, choose Word Prediction Teacher 
Controls. 

2. Click the Word Prediction Lists tab. 
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3. Select the check box next to each writing style you want 
WYNN to use. 

4. Clear the check box next to each writing style you do not 
want to use. 

5. Click the OK button.  

Creating a Custom Toolbar  
To create a new toolbar containing only certain buttons that you 
specify, choose Custom Toolbar from the Settings menu. You 
can have WYNN display this toolbar instead of the standard 
toolbars in order to provide quick access to commonly used 
commands. 

To create a custom toolbar: 

1. From the Settings menu, choose Custom Toolbar.  

 

The Customize Toolbar property page appears.  
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2. In the Available Buttons list, select the first button that you 
want to appear on your custom toolbar. 

3. Click Add to place the button to the Custom Toolbar list. 

You can add up to 14 buttons to a custom toolbar. The order 
in which you choose the buttons is the order in which the 
buttons appears on the toolbar.  

Tip: To remove a button from the custom toolbar, select it in 
the Custom Toolbar list, and click the Remove button. 

4. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

5. Click the OK button.  

If you want to use this custom toolbar in future WYNN 
sessions, be sure to save your settings. Refer to the Saving 
a Custom Toolbar section for more information. You can as 
many toolbars as you need, but be sure to save each toolbar 
under a different name. 
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Tip: WYNN includes a number of sample custom toolbars 
designed to address several particular task and 
environments. To retrieve these toolbars, choose Retrieve 
Settings from the Settings menu. 

Saving a Custom Toolbar 
After creating a custom toolbar, you can save it for future WYNN 
sessions.  

To save the toolbar: 

1. From the Settings menu, choose the Save Settings 
command.  

 

The Save Settings dialog box appears.  

2. Click the More>> button, which toggles between the Less<< 
button, and click the appropriate Settings radio button.  

3. Type a name into the Enter new settings file name edit 
box, and click the Save button to save the toolbar.  
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In the future, it can be retrieved by: 

• Clicking the Settings menu 

• Clicking the Retrieve Settings command  

• Selecting the toolbar from the Name column 

Applying Preset Toolbars 
WYNN includes a number of sample custom toolbars designed to 
address several particular task and environments.  

To use WYNN’s preset toolbars: 

1. From the Settings menu, choose Retrieve Settings. 
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The Retrieve Settings dialog appears. 

 

2. Select one of the following Custom Toolbars from the 
Name column. 
 

Custom 
Toolbars 

Toolbar Buttons 

Custom 
Web Toolbar              

   

Fluent 
Reading              

       

Public 
Access              
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Custom 
Toolbars 

Toolbar Buttons 

                   

Studying 
             

   

3. Click the OK button.  

The selected toolbar appears and replaces the four default 
toolbars. 

Improving Auditory Processing Toolbar 
This exercise is an example of how to create a customized toolbar 
to help students hear and improve text processing. Use these 
procedures to instruct students how to create an Auditory 
Processing toolbar for their own user account.  

To create the toolbar: 

1. From the Settings menu, choose Custom Toolbar.  
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The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Read, Rate, and 
Pause icons, and click Add to place the icons in the Custom 
Toolbar list.  

 

3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

4. Click the OK button.  

To save the toolbar: 
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1. From the Settings menu, choose the Save Settings 
command.  

 

The Save Settings dialog box appears.  

2. Click the More>> button, which toggles between the Less<< 
button, and click the Custom Toolbar Settings radio button.  

3. Type a name into the Enter new settings file name edit box 
(for example, Auditory Processing Toolbar), and click the 
Save button to save the toolbar.  
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4. In the future, it can be retrieved by: 

• Clicking the Settings menu 

• Clicking the Retrieve Settings command  

• Selecting the toolbar from the Name column 

Improving Vocabulary Development Toolbar 
To improve a student’s vocabulary development, you can create a 
custom toolbar specifically for this task. Follow these procedures 
to create a Vocabulary toolbar for your account. You can then 
instruct students to create their own Vocabulary toolbar for future 
assignments. 
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To create the toolbar: 

1. From the Settings menu, choose Custom Toolbar.  

 

The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Dictionary, Voice 
Note, and Read icons, and click Add to place the icons into 
the Custom Toolbar list.  

 

3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  
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4. Click the OK button.  

To save the toolbar: 

1. From the Settings menu, choose the Save Settings 
command. 

 

The Save Settings dialog box appears.  

2. Click the More>> button, and click the Custom Toolbar 
Settings radio button.  

3. Type a name into the Enter new settings file name edit box 
(for example, Vocabulary Development), and click the Save 
button to save the toolbar.  

In the future, it can be retrieved by: 

• Clicking the Settings menu 

• Clicking the Retrieve Settings command  

• Selecting the toolbar from the Name column 
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Personalizing Reading Needs  
There are several functions on the green Reading Styles toolbar 
that can assist a student with reading. You can create a custom 
toolbar that a student can retrieve that contains just those reading 
assistance functions.  

To create a reading assistance toolbar: 

1. From the Settings menu, choose Custom Toolbar.  

 

The Customized Toolbar property page appears.  

2. In the Available Buttons list, select the Size, Line Spacing, 
Word Spacing, Margins and Read icons, and click Add to 
place the icons into the Custom Toolbar list.  
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3. Select the Show Custom Toolbar radio button to replace 
the standard toolbars with your custom toolbar.  

4. Click the OK button.  

To save the toolbar: 

1. From the Settings menu, choose the Save Settings 
command. 

 

The Save Settings dialog box appears.  
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2. Click the More>> button, and click the Custom Toolbar 
Settings radio button.  

3. Type a name into the Enter new settings file name edit box 
(for example, Reading Assistance), and click the Save 
button.  

The new toolbar is saved.  

In the future, it can be retrieved by: 

• Clicking the Settings menu 

• Clicking the Retrieve Settings command  

• Selecting the toolbar from the Name column 

Tip: If you exit WYNN with a Custom Toolbar open, that toolbar is 
active the next time you log in.  

To retrieve your Default Toolbar:  

• Click the Setting menu, and then the Custom Toolbar 

• Click the Show Default Toolbars radio button, and then 
OK.  

Creating Bookmarks 
WYNN lets you bookmark important passages of text in a 
document for quick reference.  

To bookmark text in your document:  

1. Create or open an existing document. 

2. Use your pointer to select a single word or a passage of text 
in the document, and then click the Bookmark button.  
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Several different bookmark symbols appear.  

 

3. Choose a bookmark symbol from the list.  

WYNN places this bookmark symbol at the beginning and 
end of the selected text.  

To erase a bookmark:  

1. Click the Bookmark button and select the eraser at the 
bottom of the list. Your mouse pointer changes into a pencil 
eraser.  

2. Click and drag the eraser over the bookmarked text.  

Tip: You can search for bookmarks using the Find button (Writing 
Tools toolbar), or create a list of bookmarked text using the 
Lists button (Study Tools toolbar). 

Highlighting Text 
WYNN allows you to indicate important passages or key words in 
your document just as you would highlight text in a book. This 
function works in both Text View and Exact View modes.  
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To highlight text in your document:  

1. Click the Highlight button and choose a highlight color from 
the list.  

Your mouse pointer changes into a highlighter pen.  

 

2. Click and drag the highlighter pen over text you want to 
highlight.  

WYNN highlights the text using the color you selected. You 
can highlight a single word by clicking it. 

3. Click the Highlight button again when you are done 
highlighting text to return the cursor to normal.  

To erase highlighting:  

1. Click the Highlight button and then select the eraser at the 
bottom of the list. Your mouse pointer changes into a pencil 
eraser.  

 

2. Click and drag the eraser over the highlighting you want to 
remove. You can erase the highlighting for an individual 
word by clicking the word. 

Tip: You can search for highlighted text using the Find button on 
the yellow Writing Tools toolbar, or create a list of 
highlighted text using the Lists button on the pink Study 
Tools toolbar.  
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To print the highlighted text: 

1. Click the Print button (File Management toolbar). 

2. Select the Highlight Text Only radio button. 

 

Note: You must be in Text View mode to print highlighted text. 

Creating a Voice Note 
Voice Notes are useful for those with stronger auditory than visual 
processing skills. This feature allows you to use the microphone to 
record a spoken message. Teachers can create Voice Notes 
containing questions, messages, or assignments for students. 
Student can use Voice Notes to record answers to the teacher's 
questions, create reminders, or ask questions about the text. 

Note: You must connect a microphone to your sound card before 
recording a Voice Note. If necessary, refer to the 
Microphone Installation procedure described earlier in this 
document. 

To insert a voice note: 

1. Make sure that your microphone is available and turned on.  

2. Click the location in your document where you want to place 
the note, and then click the Voice Note button from the 
Study Tools toolbar.  



Teacher Exercise Guide 

 

  165  

 

The Voice Annotation dialog box appears.  

 

3. Click Record to begin recording the note, and speak your 
message into the microphone.  

The bar just above the Play, Stop, and Record buttons 
shows the relative length of your recording.  

Click the Stop button when you have finished recording the 
voice note.  

To listen to the note, click Play.  

4. When you are finished, click OK to add the note.  

A Voice Note icon appears where you added the note.  

 

Double-click this icon to listen to the note. 

Tip: You can search for Voice Notes in the document (while in 
Text View mode) by using the Find toolbar button, which 
appears on the yellow Writing Tools toolbar. 
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Paraphrasing Using Voice Notes 
Paraphrasing helps students comprehend and retain information. 
Using WYNN's Voice Notes is an invaluable tool when working on 
this learning strategy.  

The following exercises, which require you to show students how 
to record a Voice Note, can help students to improve 
comprehension: 

When students have trouble remembering homework 
assignments, have them repeat the directions verbally using Voice 
Notes. This enables you to ensure they understand the oral 
directions. 

Ask students to paraphrase or explain difficult information they are 
going to be tested on using the Voice Notes feature in WYNN. 
Paraphrasing helps to ensure their understanding and mastery of 
the material. 

When learning new vocabulary, encourage students to read the 
definitions of the new word in the dictionary and create a sentence 
using the new vocabulary word in Voice Notes. Verbal repetition 
and sentence use supports vocabulary growth. 

Creating a Text Note 
Text Notes can be added to a document to provide information or 
key instructions about a specific passage of text.  

To insert a Text Note: 

1. Open your document in WYNN.  

2. Click the location in your document where you want to place 
the note, and then click the Note button from the pink Study 
Tools toolbar.  
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The Text Annotation dialog box appears.  

 

3. Enter text into the Edit box.  

Click Read to have WYNN read the text note aloud.  

Click Paste to paste text from another document into the 
Edit box.  

Click Cancel to discard the text note.  

4. When you are finished, click OK to add the note.  

A Note icon appears where you added the note.  

 

Double-click this icon to see the text note. 

Tip: You can search for Text Notes in the document (while in Text 
View mode) by using the Find toolbar button, which 
appears on the yellow Writing Tools toolbar.  

 You can also paste text copied from other locations into the 
Text Note. For example, you can copy a definition from 
WYNN’s dictionary and paste the text into a Text Note. 



Teacher Exercise Guide 

 

 168   

Printing  
To print a document in WYNN: 

1. Open a document in WYNN. 

2. Click the Print button that appears on the blue File 
Management toolbar.  

 

3. Choose the printer you want to use to print the document, 
and then specify the parts of the document you want to print 
and the number of copies you want to create. 

Note: You can choose to print only text that you have highlighted 
in the document by selecting the Highlight Text Only radio 
button. See Highlight Text for more information.  

You can also choose to print only the content of all text notes in 
the document by selecting the Text Notes Only radio 
button. See Creating a Text Note for more information. 

4. Click the OK button to begin printing. 

Changing a Document’s Color Settings  
You can change a document’s text and background colors to help 
students read the document. There are two ways to change color 
settings: use WYNN’s preset color combinations, or manually 
create color combinations.  
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Preset Color Combinations 

To use WYNN’s preset color combinations: 

1. Open a document. 

2. From the green Reading Styles toolbar, click the Color 
button.  

 

The color button has the following color combinations: 

• Black text on a white background (default) 

• Black text on a rose background 

• Black text on a beige background 

• Black text on a sky blue background 

• White text on a black background 

3. Each time your click the Color button, WYNN cycles through 
the previously mentioned text and background color 
combinations.  

4. Choose an appropriate color combination. 

Changing Colors Manually 

To manually change WYNN’s text and background colors: 

1. From the Settings menu, choose Visual Settings. 
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The Visual Settings property page appears.  

 

2. Choose colors from the Text Color and Background Color 
list boxes.  

3. Click the OK button to save the new colors.  
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Converting Documents to MP3 or WAV File 
You can save and convert any document that you can open in 
WYNN as an MP3 or WAV file. This allows a user to listen to a 
document later using an MP3 or WAV compatible device.  

To convert a document to an MP3 or WAV file: 

1. Open a document using WYNN. 

2. Select the File menu and choose the Save to Audio 
command. 

 

The Save Pages dialog box appears. 

 

3. Do one of the following: 
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• Select the Save current page radio button to convert 
only the current page to an MP3 or WAV file. 

…OR… 

• Click the Save page range radio button to convert the 
entire document or a range of pages to an MP3 file.  

4. Click the OK button. The Save As dialog box appears.  

 

5. Enter a file name in the File name edit box, and click the 
Save button. WYNN converts the text to audio and saves the 
file into your user directory as an MP3 or WAV file.  

To listen to the file: 

1. Click your WYNN file folder icon, which appears on your 
desktop. 

2. Double-click the MP3 or WAV file.  

3. The file opens using your default audio player.  
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Student Exercise Guide 
This section describes how to perform basic tasks using WYNN.  

Cutting or Copying and Pasting Text 
The Cut/Paste button allows you to cut, copy, and paste text. You 
must enter Write mode to cut or paste text. 

To copy text: 

1. While in Write mode, select text in the document.  

  This indicates that Write mode is active. 

2. Click the Cut/Paste button.  

 

The Cut, Copy, and Paste options appear. 

• Choose Cut to delete the text and move it to the 
Clipboard.  

• Choose Copy to leave the selected text in the 
document and copy it to the Clipboard. 

The Clipboard is a temporary storage area that stores 
text that you want to move. The Clipboard can only 
hold one thing at a time. For example, if you copy text 
and then cut different text, the Clipboard only contains 
the text that you cut. 

3. Once you copy or cut text on to the Clipboard, you can paste 
it into a document (see the following procedures). 
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To paste text: 

1. Move the cursor to the place in the document where you 
want to insert the text.  

2. Click the Cut/Paste button and select Paste to insert the 
contents of the Clipboard into your document.  

You can continue to paste the contents of the Clipboard until 
you cut or copy different text. You can also paste the text 
into another WYNN document. Just click Other Doc to 
switch documents and then paste the text into the desired 
location. 

 This appears as enabled when two or more 
documents are open in WYNN.  

Tip: You can paste text from WYNN into other applications, such 
as Microsoft Word.  

You can also paste text from other applications into WYNN. 
Use the copy, cut, and paste commands in the other 
applications just as you would use them in WYNN. These 
commands usually appear on the application's Edit menu. 

Creating a Vocabulary List Using Bookmarks 
Use the Bookmark button to select specific words from a 
document, and use the Lists button to add the words to a new file.   

Selecting Words using Bookmarks 

To select words for the vocabulary list:  

1. Open a document.  
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2. From the Study Tools toolbar, use the Bookmark button to 
select words that appear in the document.  

 

For example: 

• Highlight the word or phrase. 

 

• Click the Bookmark button, and choose a bookmark 
symbol. 

 

• The bookmark symbols appear at the beginning and 
end of the selected text.  

 

3. Repeat step 2 to bookmark additional words and phrases. 

When finished, go to the next section to create the 
vocabulary list file. 
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Creating the Vocabulary List using Bookmarks 

WYNN allows you to create a new document containing text you 
have highlighted or bookmarked. You can use this feature to make 
lists of topic sentences, vocabulary words, useful facts, and more.  

To create the vocabulary list file: 

1. Click the Lists button and choose the type of list you want to 
create and how you want to sort it. 

 

2. Choose to list the text by bookmark symbol or by the order 
that you bookmarked the text.  

 

• By Bookmark Type - Creates a list of all bookmarked 
words or phrases from the original document. WYNN 
sorts the text into individual lists separated by 
bookmark type. 

• By Bookmark Order - Creates a list of all bookmarked 
words or phrases arranged in the order they appear in 
the original document 

3. After selecting the type of list sort, WYNN creates a new 
document containing the bookmarked vocabulary words.  
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The new document uses the initial file’s name, but adds the 
suffix –listx, where x is 1, 2, 3, and so on. For example, 
Flower Parts-list1.wyn. 

 

Note: If you have more than the maximum number of documents 
open, WYNN asks you to save your changes to the 
document you have accessed the least recently and then 
closes it. 

Finding a Word in the Dictionary  
There are several ways to find the definition of a word in WYNN. 

• On the Study Tools toolbar, select the Dictionary button, and 
choose the Basic Dictionary or the Standard Dictionary 

• Select the Tools menu and choose the Basic Dictionary 
command 

• Select the Tools menu and choose the Standard Dictionary 
command 

• Press the F4 function key to select the Standard Dictionary.  

The following procedure uses the Dictionary button to look up 
definitions for words in your WYNN document:  
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1. Click a word, and then from the pink Study Tools toolbar, 
click the Dictionary button.  

 

2. Choose Basic (5th grade level) or Standard (7th-8th grade 
level).  

The dictionary entry for the selected word displays as shown 
below.  

 

Tip: If you want to define a word within the definition, double-click 
the word to retrieve the definition for that word. Click the 
Previous Look-up button to return to the original word. 

3. When you finish working with the dictionary, click Close to 
return to your document. 

Finding a Word in the Thesaurus 
There are several ways to look up a word in WYNN’s thesaurus.  
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• Click the Switch to Synonyms button on the Dictionary dialog 
box.  

• Select a word and choose Thesaurus from the Tools menu. 

• Select a word and choose SHIFT+F4.  

The following procedure uses the Thesaurus command from the 
Tools menu to find synonyms for a selected word.  

1. Select a word in your WYNN document.  

2. Click the Tools menu and select the Thesaurus command.  

 

The Thesaurus dialog box appears.  
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3. Click the scroll bar in the Synonyms text box to view a list of 
synonyms for the selected word.  

Use the Read–> button, which reads the next word in the 
Synonym list, and Read <– button, which reads the previous 
word in the Synonym list, if you want WYNN to read the list 
of synonyms to you.  

Click Switch to Definition to start the Dictionary to see the 
word’s syllables and part of speech.  

4. Click the Close button to return to your document when you 
are finished with the Thesaurus. 

Hearing Text as You Type  
To customize how WYNN reads documents, menus, dialog boxes, 
toolbar buttons, and messages. 

Note: Some of these speech options may not be available, 
depending on the synthesizer you have selected. If an 
option is not available for your synthesizer, it is grayed-out.  

1. Select the Speech Settings command from the Settings 
menu.  

The Speech Settings property page appears. 
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2. Use the Read Aloud As I Type combo box to control how 
WYNN repeats what you type.  

Choose one of the following: 

• Off - WYNN does not speak any text you type.  

• Character - WYNN speaks each character you type.  

• Word - WYNN speaks each complete word you type 
after you press SPACEBAR.  

• Both Character and Word - WYNN speaks each 
character you type and then reads the word you typed.  

• Sentence - WYNN reads back the last sentence you 
typed.  

• Both Word and Sentence - WYNN speaks each word 
you type and then reads the entire sentence.  

3. Click the OK button.  
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Controlling What WYNN Speaks 
You can control which parts of the user interface that WYNN 
speaks aloud as you select menus, text, and toolbars and receive 
WYNN informational or error messages.  

By default, WYNN speaks only the text of the document when you 
click the Read button. If you wish to have additional information 
spoken, do the following to select which parts of the user interface, 
documents, and messages WYNN speaks aloud:  

1. Select the Speech Settings command from the Settings 
menu. 

 

2. The Speech Settings property page appears.  
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3. Select one or more of the following: 

 

Speak 
What?  

Check this item if …  

Text You want WYNN to read documents aloud. 

NOTE: If this is unchecked, WYNN does 
not read the document aloud when you 
select the Read button. 

Menus & 
Dialogs 

You want WYNN to speak aloud as you 
select menus and dialog boxes 

Toolbar 
Buttons 

You want WYNN to speak aloud the name 
of the toolbar button as you hover the 
mouse pointer over it 
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Speak 
What?  

Check this item if …  

Messages You want WYNN to speak aloud 
informational and error messages. 

All You want WYNN to read all text, user 
interface items, and informational and error 
messages aloud.  

None You want to mute WYNN. You want to 
mute WYNN so that it does not read 
documents aloud.  

 

4. Click the OK button.  

Highlighting Text 
WYNN allows you to indicate important passages or key words in 
your document just as you would highlight text in a book.  

To highlight text in your document:  

1. Click the Highlight button on the pink Study Tools toolbar, 
and choose a highlight color from the list.  

Your mouse pointer changes into a highlighter pen.  

 

2. Click and drag the highlighter pen over text you want to 
highlight, or use it to click and highlight a single word.  

WYNN highlights the text using the color you selected.  
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3. Click the Highlight button again when you finish highlighting 
text to return the pointer to normal.  

To erase highlighting:  

1. Click the Highlight button and then select the Eraser at the 
bottom of the list.  

Your mouse pointer changes into a pencil eraser.  

 

2. Click and drag the eraser over the highlighting you want to 
remove. You can erase the highlighting for an individual 
word by clicking the word. 

3. Click the Highlight button again when you finish erasing to 
return the pointer to normal.  

To create a list of the highlighted text:  

1. Click the Lists button on the Study Tools toolbar. 

 

2. Choose to list the text by highlighted color or by highlight 
order.  
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• By Highlight Color - Creates a list of all highlighted 
words or phrases. Text highlighted in green appears 
first in the list, text highlighted blue appears second, 
and text highlighted in magenta appears last. 

• By Highlight Order - Creates a list of all highlighted 
words or phrases in the order they appear in the 
original document.  

3. A new file appears with the list of highlighted text.  

For example:  

 

To search for highlighted text: 

1. Click the Find button from the Writing Tools toolbar.  

 

2. Choose Mark Up.  

The Find Markup dialog box appears. 
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3. Choose the Highlight radio button and click the Find Next 
button.  

The WYNN pointer moves to the next highlighted word in the 
document.  

4. To continue searching, click Find Next.  

To stop searching and close the Find Markup dialog box, 
click Cancel.  

To print the highlighted text: 

1. Click the Print button (File Management toolbar). 

2. Select the Highlight Text Only radio button. 

 

Note: You must be in Text View mode to search for highlighted 
text or to print highlighted text.  
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Listening to Voice Notes 
A Voice Note is a recorded message that appears in the 
document. The following icon represents a Voice Note.  

 

It may contain instructions from your teacher advising you about 
the exercise.   

To listen to a Voice Note: 

1. Locate and double-click the Voice Note icon. 

The Voice Annotation dialog box appears and begins to 
play the recorded message.  

 

2. Click the Play button to hear the message again. 

Click the Cancel button to close the dialog box and return to 
your document.  

Making Text Bigger 
To increase the text size that appears on your screen: 

1. Click the Size button from the green Reading Styles 
toolbar. 
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The print becomes larger on the screen.  

Continue to click the Size button until a comfortable sized 
text appears. The Size function supports eight different sizes 
of text: 10, 12, 14, 20, 24, 28, 40, and 60 point.  

2. Continual clicking of the Size button scrolls through the eight 
different text sizes.   

Masking a Document 
Masking is a special tool that shades certain parts of the 
document in order to better focus on the current line, sentence, or 
paragraph as it is being spoken.  

You can only use masking in Text View mode. 

 This indicates that Text View mode is enabled. 

To mask text in a document: 

1. Open a document, and, if necessary, place your pointer at 
the beginning. 

2. Select the green Reading Styles toolbar, and click the Mask 
button to cycle through the different masking options. 

The four masking options are:  

• No masking - No masking is applied to the document. 

• Line masking - Shades all text except the line where 
the cursor is currently located. 
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• Sentence masking - Shades all text except the 
sentence where the cursor is currently located. 

• Paragraph masking - Shades all text except the 
paragraph where the cursor is currently located. 

3. Do one of the following: 

• Click the text in the document and read it.  

…OR… 

• Click the Read button to have WYNN read the text to 
you.  

 

Note: If you turn masking on and then switch to Write mode, you 
cannot access certain WYNN commands, such as 
highlighting and bookmarks. Be sure to turn masking off 
before switching to Write mode if you want to use these 
commands. You can turn masking back on at any time. 

To turn off masking: 

• Click the Mask button until no background masking appears 
in the document.  

Tip: To make the shaded background and text lighter or darker, 
choose Masking from the Settings menu.  
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Adjusting Background Masking 

The background shading used for masking is adjustable.  

To make the background or text lighter or darker: 

1. Choose Masking from the Settings menu.  

The Masking property page appears.  

 

2. Use the Text slider to make the text lighter or darker. 

Use the Background slider to make the background lighter 
or darker.  

Use the Preview pane, which appears on the right of the 
Masking property page, to view your text and background 
adjustments.  

3. After completing the adjustment, click the Apply button to 
apply the new settings or click the OK button to apply 
changes and close the property page.  
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Opening a Web Page Using WYNN 
WYNN allows you to browse pages on the World Wide Web. The 
following section describes how to: 

• Start WYNN’s web browser 

• Change your current home page 

• Mask web pages 

• Read web pages 

To begin browsing the Web: 

1. Click the Go To Web button on the blue File Management 
toolbar.  

 

WYNN displays the Web toolbar and opens your home 
page.  

 

To change your current home page: 

1. Choose Web Settings from the Settings menu.  
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The Web Settings property page appears. 

 

2. Click any link on your home page to visit other Web pages. If 
you know the Web address of a page you want to visit, click 
the Go To Page button on the Web toolbar. Type the full 
Web address of the page and then click the Go button.  
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3. If you do not want to visit a specific Web address, you can 
search the Internet for pages containing the information you 
need. Click the Search button on the Web toolbar. Enter 
words or phrases you want to search for and click the 
Search Now button. WYNN submits the search to 
Google.com and displays the results. Click one of the links in 
the list of search results to jump to the Web page. 

Masking Web Pages 
• Once the Web page appears on your screen, you can click the 

WebMask button on the Web toolbar to shade distracting 
images and reduce visual clutter so you can focus on a specific 
element of the page.  

 

• You can also click the Text View toolbar button to see just the 
text of the page without any images or formatting. This allows 
you to use the green Reading Styles toolbar to change the 
way the text displays on your screen 

 

Reading a Web Page 

1. Click the Read toolbar button if you want WYNN to read the 
page aloud. 

2. You also have access to WYNN's dictionary so you can look 
up the definitions of words on Web pages.  

3. In addition, you can copy text, find text in the page, print the 
page, or switch to another open document. You can use the 
WYNN toolbars to perform these functions. 
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4. If you want to return to your home page, click the Home 
button on the Web toolbar. 

5. When you are finished browsing the Internet, click the Close 
Web button on the Web toolbar. 

Organizing Ideas with Outlines  
Outlines can help you organize the topics and supporting points of 
your documents. You can use outlines to plan the organization of 
research papers, summarize study materials, create plots for 
stories, and more. 

To create a new outline: 

1. Click the Outlines button from the yellow Writing Tools 
toolbar.  

 

WYNN opens a new outline document in Write mode. 
WYNN names the new document for you (for example, 
Document-outline1.wyn), but you can change this name 
when you save the outline. 

Note: If you already have the maximum number of documents 
open, WYNN prompts you to save your changes to the 
document you have accessed the least recently and then 
closes it.  

2. The new document is blank except for the first line; it 
contains the text [Title].  

3. Type a new title for the outline, and press ENTER.  

WYNN automatically numbers the first line in the outline with 
the Roman numeral one (I).  
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4. Type the information that you want to appear at this level of 
the outline and then press ENTER.  

WYNN automatically numbers the next line with the Roman 
numeral two (II).  

5. Continue adding lines to the outline until you are finished. 
You can press TAB to begin a new outline level. Use the 
Adjust button to move items in the outline.  

 

WYNN has five outline levels:  

• Outline Level 1 - Roman numerals (I, II, III...) 

• Outline Level 2 - Upper case letters (A, B, C...) 

• Outline Level 3 - Arabic numbers (1, 2, 3...) 

• Outline Level 4 - Lower case letters (a, b, c...) 

• Outline Level 5 - Lower case Roman numerals (i, ii, 
iii...) 

Tip: If you need additional assistance with WYNN's outline 
feature, refer to the Outline Tutorial in WYNN’s online help 
file. 
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Predicting the Next Word 
Word prediction helps you write by making spelling suggestions 
and anticipating the next word you are going to type. This feature 
can help you with spelling, grammar, and formulating sentences. 

To start word prediction: 

1. Click the Predict button from the yellow Writing Tools 
toolbar to activate WYNN's Word Prediction feature.  

 

The first time you start Word Prediction during a session, 
WYNN loads the word list. After the word list loads, WYNN 
displays a small prediction box on your screen.  

 

The prediction box follows your cursor as you type. If your 
cursor is within or is adjacent to a word, Word Prediction 
suggests alternative spellings for the word.  

If your cursor is not within or is adjacent to a word, Word 
Prediction suggests ideas for the next word in your 
sentence. 

2. To insert a word that appears in the prediction box, click the 
word you want to insert, or press the corresponding function 
key (F1, F2, F3, etc.).  
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WYNN inserts the specified word into your document.  

3. If you want WYNN to read the list of words to you, click the 
Speak List button.  

 

You can also right-click a word in the prediction box to have 
WYNN read the word aloud.  

Note: To modify the behavior and appearance of the Word 
Prediction feature, choose Word Prediction Settings from 
the Settings menu. To customize the word and phrase 
suggestions provided by the Word Prediction feature, 
choose Word Prediction Teacher Controls from the 
Advanced menu. 

Printing a Document in WYNN 
To print using WYNN: 

1. Click the Print button from the blue File Management 
toolbar to print the active document.  

 

2. Choose the printer you want to use to print the document.  

If necessary, specify which parts of the document you want 
to print and the number of copies you want to create.  

3. Click OK to begin printing. 
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Proofreading Your Writing Using Speech 
A review of your document with WYNN’s speech function turned 
on is one way of finding and correcting errors.  

To proofread your document: 

1. Open your document and make sure that your computer’s 
speakers are turned on or that your headphones are 
plugged in.  

2. Place your mouse pointer at the beginning of your 
document, and click the Read button.  

WYNN reads your document.  

To change WYNN’s reading speed:  

1. Click the Speech Settings command from the Settings 
menu.  

The Speech Settings property page appears. 
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2. Change the Rate setting using either the slider or your 
keyboard’s arrow keys.  

The speech rate appears below the slider scale as words 
per minute (WPM). 

3. Click the Test button to verify if the speech rate is too slow 
or too fast.  

4. Click the OK button when you are satisfied with the speech 
rate.  

Reading Syllables 
You can use WYNN to divide words into individual syllables and 
display the word's phonetic spelling.  

To see the syllables and the phonetic spelling of a word: 
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1. Click the word, and then click the Syllables button that 
appears on the Study Tools toolbar.  

The Syllabify dialog box appears.  

 

2. Click Read Word to have WYNN speak the word aloud.  

3. Click Read Phonetics to have WYNN speak the word’s 
phonetic pronunciation aloud.  

4. Click Close when you are finished to return to your 
document. 

Check Your Spelling as You Type 
WYNN can check for misspellings as you type. The misspelled 
words appear in blue text for easy identification and quick 
correction. 

To turn on spell checking as you type: 

1. From the Settings menu, select the General Settings 
command.  

The General Settings property page appears.  
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2. Choose Check spelling as I type.  

3. Open a new or existing document and begin typing.  

If you misspell a word, it appears in blue text. For example, 

 

4. Right-click your mouse on the misspelled word.  

The Spelling options appear.  
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5. Do one of the following: 

• Select the appropriate spelling 

• Ignore the misspelled word 

• Add the word to your personal dictionary 

• Open WYNN’s Spell Checker (see Spell Checking 
Your Document) 

• After choosing the appropriate option, look for the next 
misspelled word and repeat this process, or continue 
typing.  

Spell Checking Your Document 
To check your document for spelling errors: 

1. Place your mouse pointer at the beginning of the document.  

2. Do one of the following: 

• Click the F7 function key 

…OR… 

• Click the Spell Check command from the Tools menu. 
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WYNN checks your document for spelling errors. If an error 
is found, the Spell Check dialog appears. For example, 

 

3. Select one of the following options.  

Edit box or 
Button 

Function 

Word Not 
Found 

Shows the misspelled word.  

Replace With Use the List box arrow to view suggested 
spelling corrections. 

Spell 
Misspelled 
Word 

Click to have WYNN speak aloud, spell 
aloud, and speak aloud again the 
misspelled word. 

Spell 
Replacement 
Word 

Click to have WYNN speak aloud, spell 
aloud, and speak aloud again the 
misspelled word.  

Ignore WYNN does not correct the misspelling of 
this particular word.  

Ignore All WYNN does not correct the misspelling of 
this word throughout the document for the 
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Edit box or 
Button 

Function 

remainder of the session.  

Replace WYNN replaces the misspelled word with 
the word chosen in the Replace With list 
box.  

Replace All WYNN replaces the misspelled word with 
the word chosen in the Replace With list 
box throughout the document.  

Add to 
Dictionary 

WYNN adds the word that appears in the 
Word Not Found list box to the user’s 
personal dictionary.  

Close Closes the Spell Check dialog box and 
returns you to the document.  

 

4. After you choose to ignore, replace, or add the word to 
WYNN’s dictionary, the spell checker searches for the next 
misspelled word.  

The message “Spell checking is complete” appears when 
WYNN finishes.  

Spelling a Word 
If you are unfamiliar with a word in a document, use the Spell 
function to have WYNN speak, spell, and speak again the word.  

To spell a word:  

1. Click a word in your document. 
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2. Click the Spell button that appears on the pink Study Tools 
toolbar.  

3. The Spell dialog appears.  

WYNN speaks the word aloud, spells the word, and then 
speaks the word again.  

 

4. Click the Repeat button to hear the spelling again. 

5. Click the Close button when finished.  

Choosing the Correct Word 
A homophone is two or more words that are pronounced alike, but 
have different meaning and often-different spelling. Use WYNN’s 
Homophone function to verify the correct word usage in your 
document.  

To check your document for homophones: 

1. Open a document in WYNN.  

2. Do one of the following to start the homophone function: 

• Click the Homophones button that appears on the 
yellow Writing Tools toolbar. 
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…OR… 

• Select the Homophones command from the Tools 
menu.  

WYNN searches your document, from your current mouse 
pointer position, for homophones. When one is found, the 
Homophones: Sound-alike Words dialog box appears. It 
contains a list of homophones and definitions, which allows 
you to select and use the appropriate word.  

  

3. Click each homophone that appears and read its definition in 
the Definition list box, or click the Read Definition button to 
have WYNN speak the definition to you.  

4. Click the Skip button if the correct word is used. 

If the wrong word is used, choose the word from the 
Homophones list box and click Replace.  

After selecting, WYNN continues to search for the next 
homophone.  

5. To stop the homophone search, click Close to return to your 
document.  
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System Requirements 
The following is the minimum software and hardware required for WYNN 
single-user and client installations.  

System 
Components 

Minimum System Requirements 

Operating 
System 

Windows XP/NT/2000/Me/98 

Web Browser Windows Internet Explorer 6.0 or later; 
Netscape 7.0 or later 

Processor Pentium 400 or better processor 

Hard Disk 400 MB of available hard disk space  
(plus additional space for document 
storage) 

Memory 128 MB RAM 

CD-ROM 
Drive 

CD-ROM drive or DVD-ROM drive for 
software installation 

Sound  Sound card and speakers or an SSIL-
supported speech synthesizer with 
speakers. Microphone jack. 

Video  Video card and monitor capable of at 
least 800x600 resolution with 256 color 
mode or greater 

Internet 
Connection 

Local area network, modem, or DSL 
connection to the Internet for product 
activation 
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System 
Components 

Minimum System Requirements 

Scanner TWAIN compatible scanner  
(optional for WYNN Wizard; not required 
for WYNN Reader) 

Network 
Version 

Novell Netware or Windows NT/2000 
server 
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WYNN Shortcut Keys 
This section lists keystrokes you can press to perform various functions in 
WYNN. 

General Commands 
General Commands Shortcut Keys 

Start WYNN ALT+CTRL+W 

Quit WYNN ALT+F4 

Switch between Text View and Exact 
View 

CTRL+SHIFT+
V 

Show/Hide Menu Bar SHIFT+F3 

Show/Hide Status Bar SHIFT+F5 

Help F1 

 

File Management Commands 
File Management Commands Shortcut Keys 

Open File CTRL+O 

Close Document CTRL+F4 or 
CTRL+W 

Create New Document CTRL+N 

Save Document CTRL+S 

Print CTRL+P 

View Document Properties CTRL+R 
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Reading and Editing Commands 
Reading and Editing Commands Shortcut Keys 

Begin Reading F2 

Switch between Read-only Mode and 
Edit Mode 

CTRL+E 

Go to Page CTRL+G 

Undo CTRL+Z 

Copy Selected Text CTRL+C 

Cut Selected Text CTRL+X 

Paste Text from  
Clipboard 

CTRL+V 

Select All CTRL+A 

Delete Selected Text DELETE 

Bold Selected Text CTRL+B 

Italicize selected Text CTRL+I 

Underline Selected Text CTRL+U 

Find Text CTRL+F 

Find/Replace Text CTRL+H 

Insert Page Break CTRL+ENTER 

Delete Page Break CTRL+SHIFT+ENTER

Delete Current Page CTRL+DELETE 

Look Up Selected Word in the Standard 
Dictionary 

F4 

Look Up Selected Word in the SHIFT+F4 
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Reading and Editing Commands Shortcut Keys 
Thesaurus 

Spell Check F7 

Spell Word F6 

 

Mark-up Commands 
Mark-up Commands Shortcut Keys 

Find Mark-up CTRL+M 

Highlight Selected Text F8 

Insert Bookmark F9 

Insert Text Note F10 

Insert Voice Note F11 

 

Scanning Commands 
Command Shortcut Keys 

Scan a Page F3 

Switch between Text View and Exact 
View 

CTRL+SHIFT+V

Document Clean-up SHIFT+F7 

Enable Dynamic Zoning and Show 
Current Zones 

CTRL+F5 

Redefine Zones on Current Page CTRL+D 
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Command Shortcut Keys 

Re-recognize Document CTRL+Q 
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WYNN Menus 
This section lists each command available on the WYNN main menu bar. 
The second column lists the shortcut keys you can press to quickly 
activate the corresponding command. 

File Menu 
File Menu Commands Access Keys 

New ALT+F, N 

Open ALT+F, O  

Close ALT+F, C 

Save ALT+F, S  

Save As ALT+F, A 

Save Pages ALT+F, G 

Enable Multi-user Logins ALT+F, E 

Login Different User ALT+F, L 

Print ALT+F, P 

Print Preview ALT+F, V 

Print Setup ALT+F, U 

Document Properties ALT+F, R  

Exit ALT+F, X 
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Edit Menu 
Edit Menu Commands Access Keys 

Edit Mode/Read-only Mode ALT+E, E 

Undo ALT+E, U  

Cut ALT+E, T 

Copy ALT+E, C 

Paste ALT+E, P 

Delete ALT+E, D 

Select All ALT+E, S  

Bold ALT+E, B  

Italic ALT+E, I  

Underline ALT+E, U  

Find Text... ALT+E, F  

Find/Replace Text... ALT+E, R  

Find Mark-up... ALT+E, M  

Go to Page.. ALT+E, G  

Renumber Pages... ALT+E, A 

Insert Page Break ALT+E, I  

Delete Page Break ALT+E, L  

Move Page... ALT+E, O 

Delete Current Page ALT+E, N  

Create Outline  ALT+E, O 
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Edit Menu Commands Access Keys 

Outline Adjustments ALT+E, J 

 

Scan Menu 
Scan Menu Commands Access Keys 

Scan Page ALT+S, S  

Scan and Replace Current Page ALT+S, R 

Scan and Insert New Page ALT+S, I 

Recognize Columns ALT+S, Z 

Color Scanning ALT+S, C 

2-page Scanning ALT+S, 2 

Most Accurate Scanning ALT+S, A 

Fastest Scanning ALT+S, F 

 

View Menu 
View Menu Commands Access Keys 

Show Exact View/Text View ALT+V, H  

Menu Bar ALT+V, M  

Toolbar ALT+V, T 

Status Bar ALT+V, S  

Zoom Exact View ALT+V, Z 
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View Menu Commands Access Keys 

Page Scrolling ALT+V, P 

 

Tools Menu 
Tools Menu Commands Access Keys 

Start Reading ALT+T, H  

Spell Check ALT+T, P  

Word Count... ALT+T, R 

Spell Word... ALT+T, W  

Syllabify Word... ALT+T, Y 

Homophones ALT+T, O 

Word Prediction ALT+T, O, O 

Basic Dictionary... ALT+T, B  

Standard Dictionary... ALT+T, D  

Thesaurus... ALT+T, T  

Start Highlight ALT+T, H  

Highlighter Pens ALT+T, G 

Lists ALT+T, L 

Insert Bookmark ALT+T, I  

Bookmark Type ALT+T, B 

Insert Text Note... ALT+T, N  

Insert Voice Note... ALT+T, V 
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Advanced Menu 
Advanced Menu Commands Access Keys 

Pronunciation Dictionary ALT+A, P  

Dynamic Zoning ALT+A, Z 

Document Cleanup ALT+A, D 

OCR Correction... ALT+A, O 

Scanner Selection... ALT+A, S 

Teacher Lockout ALT+A, T 

Word Prediction Teacher Controls... ALT+A, W 

 

Settings Menu 
Settings Menu Commands Access Keys 

Save Settings... ALT+G, S 

Retrieve Settings... ALT+G, R 

Delete Settings... ALT+G, D 

Speech Settings... ALT+G, P 

Visual Settings... ALT+G, V 

Scanning Settings... ALT+G, C 

General Settings... ALT+G, G 

Email Settings... ALT+G, E 

Masking... ALT+G, M 

Differential Coloring... ALT+G, O 
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Settings Menu Commands Access Keys 

Word Prediction... ALT+G, I 

Custom Toolbar... ALT+G, T 

Web Settings... ALT+G, W 

 

Web Menu 
Web Menu Commands Access Keys 

Back ALT+B, B 

Forward ALT+B, F 

Stop ALT+B, T 

Refresh ALT+B, R 

Home  ALT+B, H 

Open Web Page ALT+B, O 

Close Web ALT+B, C 

Search the Web ALT+B, W 

Go To Web Page... ALT+B, G 

History... ALT+B, Y 

Favorites... ALT+B, A 
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Window Menu 
Window Commands Access Keys 

Next Document ALT+W, N 

 

Help Menu 
Help Menu Commands Access Keys 

Search for help on... ALT+H, S 

WYNN Help... ALT+H, H 

About WYNN... ALT+H, A 
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Activation Options 
Software activation is an easy, one-time process that uses a 20-character 
Authorization code to help Freedom Scientific verify your product’s 
license. The Authorization code is available on the Authorization CD and 
WYNN’s CD package. Use the Authorization CD to copy the code to your 
PC. This saves the time and trouble of having to manually type the 20-
character code during the Activation process.  

If you do not have immediate Internet access, use the procedures in this 
chapter to activate your product. 

Before You Begin:  
• Locate your 20-character Authorization number, which appears on the 

WYNN product packaging. 

• Install your 20-character Authorization number as previously described 
in the Copying the WYNN Authorization Number section. 

• There are several ways to activate WYNN. Determine which method 
you want to use. For example: 

• Use the Internet to connect directly to Freedom Scientific and 
use the automated activation process. This is the fastest 
method and is recommended, as described in the WYNN 
Installation Process section.  

• Call Freedom Scientific’s Customer Support and request that 
an Activation License code be sent to you by e-mail or on a 
CD.  

• Send a fax to Freedom Scientific’s Customer Support and 
request that an Activation License code be sent to you by e-
mail or on a CD. 

• Use another computer with Internet connectivity to download 
an Activation License code from FSActivate.com. Once it is 
received, it can be copied to a disk or CD-ROM and used to 
activate WYNN.  
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Starting the Activation Process  
Until you activate WYNN, the Activation dialog box appears each time 
you try to open the WYNN application.  

To start the activation process:  

1. Select the WYNN application shortcut from the desktop. 

2. From the WYNN Activation dialog box, click Activate.  

 

3. A WYNN dialog box appears. It contains the various activation 
methods.  
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If you do not have immediate Internet access to activate the WYNN 
application, choose one of the following activation methods:  

• Activating by telephone 

• Activating by fax  

• Activating using FSActivate.com 
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Activating by Telephone 
There are two ways to request activation by calling Freedom Scientific 
directly.  

• Call and request that an Activation code be emailed to you. 

• Call and request that an Activation code be mailed to you. 

Note: Activation by mail takes several days to complete since a CD must 
be mailed to you. 

Requesting an Activation Code by Telephone  

To activate your product after receiving the Activation code in an email:  

1. From the WYNN Activation dialog, select Telephone to receive 
activation by mail, and click Next.  

 

2. Record your Locking code and the Customer Service phone 
number. Click Quit and exit WYNN activation.  
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Keep your Locking code, Customer Service phone number, and 
Authorization number, which also appears on your WYNN CD 
package, in a safe place. You will need this information later when 
calling Freedom Scientific. 

3. Call Customer Service (727-803-8015), request an Activation 
License code, and provide your Locking code and Authorization 
number.   

4. If activating using an Activation code received by email, 

• When the email arrives, start WYNN, select Activate, select 
Telephone to receive activation by mail, and click Next.  

• Copy the 100-plus character code from the email message, 
and paste it into the Activation License Code edit box. Click 
Next.  
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If activating using an Activation code received by mail, 

• When the Activation License code CD arrives, insert it into the 
computer’s CD-ROM drive, and let the auto-run feature start 
the Activation program.  

• When requested, click Activate Using Authorization CD, 
and follow the on-screen instructions. If necessary, enter your 
Locking code and Authorization number when requested.  

If activation is successful, a confirmation message appears. 

5. Click Finished, which completes the activation. 

If the activation fails, a detailed error message appears that 
recommends you verify or reenter your authorization code, or that 
you contact Freedom Scientific for assistance. 
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Activating by FAX 
You can print, complete, and fax a request form to Freedom Scientific’s 
Customer Service requesting that an Activation License code be sent to 
you by email or postal service.  

Note: This method of activation takes several days to complete since a 
CD must be mailed to you. 

Requesting an Activation Code by Fax  

To receive the Activation code using email: 

1. From the WYNN Activation dialog, select Telephone to receive 
activation by mail, and click Next.  

 

2. Record your Locking code.  
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Keep your Locking code and Authorization number, which appears 
on your WYNN product box, in a safe place. You will need this 
information later.  

3. Click Back, select Fax, and click Next.  

 

The Activation License code request form appears.   
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4. Print and complete the form, and fax it to Customer Service (727-
803-8001). Make sure that you enter your Authorization number, 
and if requesting an Authorization number by email, a valid email 
address.   

 

5. Quit the WYNN Activation dialog box.  

6. If activating by email, 

• When the Activation License code arrives by e-mail, start 
WYNN, select Activate, select Telephone to receive 
activation by mail, and click Next.  

• Copy the 100-plus character Activation License code from the 
e-mail message, and paste it into the Activation License 
Code edit box. Click Next.  
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If activating by mail, 

• When the Activation License code CD arrives, insert it into the 
computer’s CD-ROM drive, and let the auto-run feature start 
the Activation program. 

• When requested, click Activate Using Authorization CD, 
and follow the on-screen instructions. If necessary, enter your 
Locking code and Authorization number when requested.  

If activation is successful, a confirmation message appears.  

7. Click Finished, which completes activation. 

If activation fails, a detailed error message appears that 
recommends you verify or reenter your activation license code, or 
that you contact Freedom Scientific for assistance. 

Activating using FSActivate.com 
Another method for obtaining an Activation License code is to download 
the code using another person’s computer, and then copying the code to 
your computer using a floppy disk or CD-ROM.  

Note: The other person’s computer must have Internet access.  

Using your computer: 
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1. From the WYNN Activation dialog, select Activation generated 
from www.FSActivate.com, and click Next.  

 

2. Record your Locking code.  
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Keep your Locking code and Authorization number, which appears 
on your WYNN CD package, in a safe place. You will need this 
information later.  

3. Quit the WYNN Activation dialog box.  

Using the other person’s computer: 

1. Use a trusted third party’s computer with Internet access to connect 
to Freedom Scientific’s product activation page 
(http://www.FSActivate.com). 

2. Click Continue, and scroll down until the Authorization number 
and Locking Code edit boxes appear. 

3. Enter your Authorization number and Locking code, and click 
Submit License Request.  

4. Save the generated License code as an HTML or text file to a 
floppy disk or CD-ROM and transport to your computer. 

 

Using your computer: 

1. At your computer, start WYNN, select Activation generated from 
www.fsactivate.com to receive activation by mail. 

• Insert the floppy disk or CD-ROM into your computer, and 
copy the 100-plus character License code from the file.  
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• Paste the entire License code into the Activate License 
Code edit box, and click Next.  

 

If activation is successful, a confirmation message appears.  

• Click Finished, which completes activation. 

If activation fails, a detailed error message appears that 
recommends you verify or reenter your Authorization number, or 
that you contact Freedom Scientific for assistance. 

Activating using the Activation Media Image Creator 
Program 

The Activation Media Image Creator program provides an alternative 
method if you must activate several PCs that do not have access to the 
internet. 

To activate these PCs, you need: 

• One PC that can access the Internet and download the Activation 
Media Image Creator program 

• The Locking codes and the Authorization numbers of the PCs that 
require activation 

Do the following to download this program: 

1. Using your browser, enter the URL www.fsactivate.com. 

2. Select the FS Product Activation Site link and then select Continue. 

3. Select the Activation Media Image Creator link. 

http://www.fsactivate.com/
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4. Read the on-screen instructions and download the Activation Media 
Image Creator program. Follow the on-screen instructions provided 
with the program. 
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Activating the License Server through a 
Software Firewall 

Note: The following provides a general overview for reconfiguring your 
firewall settings. For a specific example of how to configure your 
firewall settings using Windows Firewall, refer to Configuring 
Windows Firewall.  

General Overview 
If your firewall software prevents you from activating WYNN using the 
Internet, reconfigure the firewall to allow the following files to run:  

• FSActivate.exe 

• CAUtil.exe 

• CAUtil.enu.  

Note: Temporarily disable Windows firewall while performing this 
procedure.  

Once you have reconfigured your firewall, retry the activation process. 
The following is a complete list of all files that need to be allowed by the 
firewall when using WYNN: 
 

File Name Connection 
Type 

Incoming 
Port 

Outgoing 
Port 

C:\WYNN4nw\WYNN.exe or 
C:\WYNN4nw\WYNNR.exe UDP 5093 5093 

C:\WYNN4nw\WYNN.exe or 
C:\WYNN4nw\WYNNR.exe 

UDP 5094 5094 
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File Name Connection 
Type 

Incoming 
Port 

Outgoing 
Port 

C:\WYNN4nw\WYNN.exe or 
C:\WYNN4nw\WYNNR.exe 
(Only required if using 
redundant license servers) 

UDP 5096 5096 

C:\Program Files\Freedom 
Scientific\Activator\1.1\ 
CAUtil.dll 

TCP/IP 80 80 

C:\Program Files\Freedom 
Scientific\Activator\1.1\ 
CAUtil.dll 

TCP/IP 20 21 

C:\WYNN4nw\FSAuth.exe UDP 5093 5093 

C:\Program Files\Freedom 
Scientific\Activator\1.1\ 
FSActivate.exe 

TCP/IP 80 80 

If you cannot reconfigure the firewall, or if you still cannot activate the 
software, go to www.FSActivate.com. Follow the instructions on the 
Web page to retrieve an Activation License code.  

Finding your Locking Code 

To use FSActivate.com, you need your Authorization number and the 
license server’s Locking code. Do the following to find the Locking code:  

1. From the Start menu, choose Programs or All Programs, Freedom 
Scientific, Network, and Update WYNN Authorization. 

2. Choose Start Activation.  

http://www.fsactivate.com/
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3. If you are asked to insert your Authorization CD, specify that you 
want to enter the Authorization number manually.  

4. Choose Activate.  

5. Select the Telephone to Receive Activation by Mail option and 
press ENTER. The server's Locking code is shown on the page that 
appears.  

6. After you copy the Locking code, choose Quit.  
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Configuring Windows Firewall 
The following describes how to configure and open ports using Windows 
Firewall for use with WYNN4nw. 

1. From the Start button, select Control Panel.  

2. Select Windows Firewall, and then select the Exceptions tab. 

 

3. Select the Add Port button, enter a name in the Name field (for 
example, UDP port 5093), enter port number 5093 in the Port field, 
and select the UDP radio button. Click OK. 
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UDP port 5093 now appears in the Programs and Services list box.  

 

4. Repeat step 3 for the following ports: 

Port Number Connection Type 

5094 UDP 

5096 UDP 

80 TCP 

21 TCP 

20 TCP 
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5. From the Exceptions tab, click the Add Program button.  

The Add a Program dialog box appears.  

 

6. Click the Browse button, and locate and select the FSActivate.exe 
file.  

For example: 

C:\Program Files\Freedom Scientific\Activator\1.1\FSActivate.exe. 

FSActivate now appears in the Programs list. 
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7. Select the OK button to close and save the Windows Firewall 
settings.  
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